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RESUMEN 

 

El presente trabajo sobre análisis y diseño estructural, sobre el uso de 

programas de Análisis y Diseño estructural, como  Etabs, aplicado a estructuras 

de concreto armado y específicamente a edificios de varios niveles, se enfoca al 

buen uso y aplicación del mismo. 

Se analizó un edificio de 14 niveles,  en concreto armado y de estructuración  o 

configuración típico en construcción en  Guatemala,  aplicando todos los 

criterios y requerimientos solicitados por códigos que normalmente se usan en 

nuestro país. 

Se definen todos los parámetros según códigos, y siguiendo una secuencia de 

desarrollo, de todos los elementos como Losas, vigas, y columnas,  que es la 

parte inicial de geometría del edificio según planos arquitectónicos, comentando 

cada paso, de tal forma que el lector pueda desarrollar estructuras similares. 

La segunda fase trata sobre la aplicación de cargas gravitacionales y sísmicas, 

donde se conjuga el criterio estructural para ir verificando que el programa  no 

aplique por default datos, que es una parte de estos programas que si no se 

tiene cuidado, el mismo sólo aplica los parámetros estructurales y se comienza 

a perder el control sobre el modelo, que es lo que este trabajo pretende enfocar, 

y así evitar  errores  considerados como graves. 

En la tercera fase se enfoca al análisis y diseño estructural, y donde el criterio 

estructural se debe prevalecer, caso contrario se pueden asumir datos erróneos 

o dejar que el programa los aplique por default,  y por lo tanto el modelo ya no 

representará lo que inicialmente se requería analizar y diseñar. 
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De tal manera, que este trabajo pretende evitar todos estos errores graves que 

se puedan incurrir al no tener claro el uso de estos programas,  y en el mejor de 

los casos ayudar aquellos que tienen un buen criterio estructural a confiar en el 

mismo. Además de los chequeos paralelos que se deben llevar en programas 

en hojas Excel, esto con la finalidad de tener siempre el control total sobre los 

programas como Etabs. 

Finalmente estos chequeos dan la certeza  y confiabilidad de los programas 

mencionados, y  su vez que el profesional en ingeniería estructural de un paso 

hacia los avances de la tecnología. 
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OBJETIVOS 

 

General 

El presente estudio especial de graduación, es desarrollar confianza en estos 

programas, para Análisis y diseño estructural de Edificios de concreto armado, y 

que pueda ser aplicado en Guatemala,  ayudando a estudiantes y profesionales 

de ingeniera civil y estructural, a confiar  en estos programas y no solamente 

verlo como algo fácil de usar. 

Específicos 

1. Desarrollar un estudio que ayude al buen uso del programa Etabs, en 

análisis y diseño. 

 

2.  Que de confianza en el desarrollo de análisis y diseño estructural en 

edificios de concreto armado. 

 

3. El Análisis estructural a realizar será un estático equivalente y un análisis 

dinámico con criterios de IBC06 - AGIES,  y su aplicación sea para parte 

del desarrollo de la ingeniería estructural en Guatemala. 

 

4.  Ayudar a comprender el  alcance de estos programas para el uso 

adecuado  de los mismos, por consiguiente el diseño estructural se 

basará estrictamente en dos elementos, viga y columna. 

 

5. Hacer conciencia en la  ingeniera  estructural, que estos programas no es 

sólo  ingresar datos, esto debido a que el programa cada vez es más 
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amigable su uso, pero se debe tener cuidado, porque facilita el cometer 

errores graves. 

 

6. Que se convierta el estudio en consulta para profesionales y estudiantes 

de ingeniería civil y maestría estructural, y sea sujeto de críticas y 

mejoras en el transcurso de su uso. 

 

7. Que sea parte de bibliografía a usar en los cursos de Diseño Estructural, 

Concreto armado I y II, para desarrollar el mismo de forma paralela al 

programa  en estos cursos. 
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INTRODUCCIÓN 

En la ingeniería estructural, la  tecnología se ha desarrollado a pasos 

agigantados y el uso  de programas para análisis y diseño estructural ha llegado 

a las universidades  sin tener una base de aplicación sólida, por lo que este 

estudio se enfoca en el buen uso y confianza del programa. 

Etabs es parte de programas que cumplen las características antes descritas, 

además de conocidos y usados por la ingeniería civil y Estructural de 

Guatemala, y para solucionar ese problema, COMPUTER & STRUCTURES 

INC. Se obtuvo el  apoyo incondicional para poder llevar adelante este proyecto 

o trabajo especial para la maestría de estructuras. 

El presente trabajo aplicado a edificios de Concreto Armado, se desarrollará 

paso a paso, y explicará cómo es el uso y aplicación correcta del programa a 

utilizar, y a su vez comprobar los resultados, con esto se tendrá la certeza y 

seguridad que los diseños y cálculos estarán dentro de los parámetros que los 

códigos de diseño estructural exigen. 

Por lo tanto se estará cubriendo una buen sector de la ingeniería estructural en 

Guatemala, ya que un 90% de los edificios construidos son de concreto 

armado, en consecuencia se dará un gran apoyo a la ingeniería estructural, 

además de la confianza en la utilización del programa Etabs, que actualmente 

son usados por estudiantes de pregrado, creyendo que con dos clases ya se 

puede realizar análisis y diseños estructurales, esto debido a que los programas 

son bastante amigables, pero cuando se deben trabajar conceptos  

estructurales, la situación cambia y los problemas comienzan a salir, es decir 

los resultados no son los esperados, y muchas veces los diseños comienzan a 

ser sobrediseñados o caso contrario subdiseñados. 
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Al hacer uso indebido de estos programas, se tiende a caer en  muchos errores 

que  son catastróficos ya sea económicamente o estructuralmente, en el primer 

caso seguramente nos tildaran de incompetentes y definitivamente nos 

desprestigiaran, siendo la solución estudiar más, pero en el segundo caso 

además de incompetentes, se sumara el problema legal y definitivamente en 

lugar de ganar perderemos dinero y prestigio. 

Entonces, este estudio pretende ser una guía para evitar errores en la 

ingeniería estructural y que los estudiantes de pregrado y maestría, aparte de 

su uso aporten sus comentarios para beneficio de la población ingenieril. 

La base de este trabajo está fundamentada en: 

1.-Programa de análisis y diseño estructural Etabs. 

2.-Reglamento de las construcciones de Concreto Reforzado ACI318-05 

3.-Código Internacional de Construcción (International Building Code) -IBC 2006 

4.-Estándar de Cargas Mínimas de Diseño para Edificios y otras Estructuras 

(MÍNIMUM DESIGNÓ LADOS FORO BILLINGS AND OTERO STRUCTURES) -ASCE 7-05. 

5.-Normas estructurales para Guatemala - AGIES 

Cabe mencionar que el programa tiene definidos estos y otros códigos según 

requerimientos, No así el de AGIES. Pero se indicará como se pueden aplicar 

los criterios de AGIES. 
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CAPÍTULO 1 

Ingeniería Estructural  

 1.1-Teoría y conceptos aplicados en Ingeniería estructural. 

La ingeniería estructural  es la elaboración de propuestas de solución en 

términos de conceptos  estructurales, es decir alternativas que permitan 

resolver el problema de la existencia de la estructura. Refiriéndose a las 

posibilidades del equilibrio y de la estabilidad que debe existir antes de realizar 

una comprobación numérica. 

Se inicia la concepción estructural, cuando se definen los sistemas resistentes, 

eligiendo los tipos  y sistemas estructurales y organizándolos en el espacio, 

siendo lo más importante del proceso de análisis y diseño, una vez definido el 

sistema resistente, el resto del proceso es una consecuencia.  Esta etapa   

requiere experiencia, de todos modos la única manera de adquirir experiencia 

en esta área estructural, es intentar un diseño y luego criticarlo, es decir 

analizarlo para estudiar sus ventajas y desventajas. 

Algo muy importante es la relación que debe existir desde un inicio entre 

arquitectura e ingeniería estructural, ya que frecuentemente se adoptan 

estructuras con características incompatibles con el diseño arquitectónico, 

llegando a crear estructuras híbridas, una serie de combinaciones, como 

elementos muy rígidos con estructuras de mampostería, quedando en el olvido 

los sistemas definidos como marcos espaciales resistentes a momento, muros 

de corte. 

También se tiende a usar estructuras que compiten con el espacio físico con 

funcionales, cuando se utilizan marcos internos, cuando la altura disponible 

para vigas o columnas está limitado por las necesidades funcionales. 
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Normalmente se tiende a considerar una estructura que se apoya en la 

cimentación y esta a su vez al suelo y no se consideran las deformaciones, o en 

el peor de los casos que éstas no influyen sobre la estructura.  La anterior 

suposición no es válida y menos para acciones horizontales importantes (sismo 

o viento), en consecuencia la estructura es una sola, es decir: estructura, 

cimentación y suelo forman un único sistema resistente que debe ser estudiado 

globalmente.  Por lo tanto desde un principio se debe considerar cada sistema 

estructural en relación con las posibilidades de cimentación y la interacción con 

el suelo. 

1.2.- Ingeniería estructural de análisis y diseño 

Cuando los análisis estructurales tienden a ser eficaces, tienden a poner en 

evidencia las interacciones entre los distintos sistemas que componen la 

estructura, la dificultad más grande que uno encuentra es modelar la estructura, 

ya que aquí es donde se trata de definir dimensiones con una precisión 

adecuada para garantizar la compatibilidad final de la solución estructural. 

La solución elegida debe ser viable desde el punto de vista estructural, y que 

garantice el equilibrio, las dimensiones deben ser funcionales y aceptables 

económicamente. 

El concepto de análisis y diseño, no debe ser una receta, debe ser el resultado 

de la interpretación física, si se sabe cómo funciona una estructura, se puede 

obtener un modelo analítico y en consecuencia saber cómo se deformará. 

Para aprender a modelar, se debe plantear también los sistemas resistentes y 

saber interpretar los resultados, en particular las deformaciones, se debe tener 

presente que existen varios modelos que describen todos los aspectos del 

funcionamiento de la estructura. 
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Normalmente se emplea más de uno y sus envolventes nos permiten calcular  

el funcionamiento más probable intermedio de la estructura real, como cada vez 

existen más medios y técnicas para modelar, es por eso que en este estudio se  

usará el programa de Etabs, que hace posible una mayor precisión en la 

descripción de los fenómenos físicos. 

Una vez superada la etapa de análisis estructural de los sistemas 

seleccionados, se puede entrar en la etapa de diseño estructural de los 

diferentes elementos de concreto reforzado. En esta etapa se tienen dificultades 

prácticas  para interpretación, verificación y armado de elementos de concreto 

armado, sometidos a distintas solicitaciones. En consecuencia este análisis y 

diseño  de estas, ayudará a enfocar esta etapa de una manera  eficiente, 

dejando plasmado paso por paso y criterios de experiencia. 

1.3.- Ingeniería estructural de Detalle. 

Existen varias  de maneras de armar una estructura, algunas son buenas y no 

todas son adecuadas para un caso específico, sin embargo hay bastantes 

maneras de armar mal una estructura. 

Esta parte se convierte en un arte el cual debe ser practicado con constancia y 

sobre todo con sentido crítico, observando todos los problemas de obra 

(sistema constructivo), se hace recomendable visitar obras similares que estén 

en construcción, como una actividad creativa de aprendizaje personal.  También 

hay que estudiar planos de detalles de armado, buenos y malos, y aprender a 

distinguir unos de otros, y siempre teniendo en cuenta que el papel aguanta con 

todo, y  en la realidad hay detalles estructurales que no se  pueden ejecutar. 

Si se tiene en consideración en los planos se dibuja todo, pero muchas veces 

sin llegar al detalle, por lo tanto es recomendable realizar los mismos a una 

escala donde puedan dibujarse y visualizarse los diámetros de los refuerzos, 

para realmente ver cómo quedaría la sección armada,  además de las uniones 
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por donde pasan  varias vigas, convirtiéndose estas áreas en imposibles de 

armar en campo, en consecuencia esta idea de ingeniera estructural de detalle 

es sumamente importante, ya que si bien todos los cálculos quedan dentro de 

los parámetros requeridos, un mal detallado lo convierte en un punto crítico en 

la estructura, y si consideramos que pasa hasta en un 80% de los nudos o 

puntos requeridos estaremos entregando una estructura totalmente diferente a 

la concebida y en consecuencia un problema muy serio para el proyecto 

idealizado y más aun a la ingeniería estructural, por lo tanto,  esto es uno de los 

puntos en los cuales se pondrá atención, y fundamentar el criterio que todo 

proyecto es único, lo cual nos lleva a actuar como profesionales y no solamente 

copiar detalles y plasmarlos en los planos. 
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CAPÍTULO 2 

Proyecto de Análisis y Diseño. 

El proyecto  para realizar un análisis y diseño, basado en el programa Etabs, es 

un edificio que pertenece a Construcciones CYPSA  y proyectado a construirse 

en Av. Las Américas  3-17 zona 14, con 5 sótanos y 14 niveles. Y un área total 

de 16,499.00 mts.2 

Antes de realizar un análisis general del proyecto, es necesario tener presente 

los alcances que se pretenden evaluar y que son obligatorios, como su 

geometría en planta y elevación, ubicación, diseño arquitectónico, uso,   y que 

en los siguientes subcapítulos se pretende dejar claro su alcance y su 

aplicación a este proyecto. 

2.1 Funcionalidad estructural para análisis. 

En esta etapa se pretende entender y dar a conocer la funcionalidad de una 

estructura, de tal forma que su análisis nos proporcione los parámetros de 

ingeniería esperados y aceptables, entonces podemos mencionar una infinidad 

de estructuras, pero se centrará  la información en estructuras de concreto 

reforzado y específicamente marcos espaciales resistentes a momento. 

Al hacer un estudio general de las maneras en que la configuración y 

funcionalidad influyen sobre el análisis y diseño sísmico, se destacan los 

aspectos que a continuación se mencionan: 

Altura: 

Para un edifico puede parecer equivalente al aumento del claro de una viga en 

voladizo, el período de un edificio no es solamente una función de su altura, 

sino también de factores como la relación entre altura y ancho, altura de piso, 

material y sistema estructural, de este modo si se cambia el tamaño del edificio, 
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al mismo tiempo cambia una o más variables, como su período, y por lo tanto 

aumentan o disminuyen las fuerzas sísmicas. 

Aunque muchos edificios de mediana altura se construyen con costo más bajo y 

especulativo, los edificios más altos generalmente tienen mayor inversión en 

ingeniería estructural, y considerando que Guatemala es una zona altamente 

sísmica, se tiende a usar marcos (dúctiles) espaciales resistentes a momento. 

Ancho: 

Las fuerzas de volteo es fácil relacionarlas con la altura, pero las plantas 

grandes o anchas también tienen inconvenientes,  cuanto más ancho sea el 

edificio, las diversas partes de la base del mismo, vibran asincrónicamente con 

aceleraciones diferentes, llegando a provocar destrozos en el edificio ancho, y 

por tal motivo tiene la mayor probabilidad de ocurrencia de estos esfuerzos y 

mayor será su efecto distorsionante. 

Proporción: 

Las proporciones de un edificio pueden ser más importantes que su tamaño 

absoluto, entonces la relación altura/ancho, calculada  de la misma manera que 

para una columna individual, es muy importante o más que sólo su altura. 

Mientras más esbelto sea un edificio, más significativos serán sus efectos de 

volteo ante un sismo o viento, y considerando los esfuerzos sísmicos en las 

columnas exteriores, en especial las fuerzas de compresión por volteo, éstas se 

consideran difíciles de manejar. 

Se tiene datos de que las elevaciones mayores tengan cuando menos un ancho 

de 18 mts. Es decir una relación de 4 admite aproximadamente 20 pisos, estas 

relaciones de esbeltez comparativas demuestran que los edificios altos o 

rascacielos no son considerados esbeltos, como lo demuestra la Figura 1.  
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FIGURA 1. Relaciones de esbeltez de edificios altos. 

Así se tiene las diferentes relaciones y vemos que están por arriba de la 

relación 4:1 (10:1- 7:1 -  etc.). 

El equivalente en planta se conoce como relación de aspecto, la misma 

generalización es válida, las formas largas y esbeltas son inconvenientes. 

Simetría: 

Es la propiedad geométrica de la configuración del edificio, un edificio es 

simétrico respecto a sus ejes en planta; si su geometría es idéntica en 

cualquiera de los lados de los ejes que se estén considerando. 

Aquí también se debe considerar la simetría tanto en planta como en elevación, 

por lo tanto las formas simétricas son preferibles a aquellas que no lo son. 

Existen dos razones básicas, la primera es que la asimetría produce torsión, 
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además de otras variaciones como el peso, y la segunda razón es que se 

inducen concentración de esfuerzos. 

Lo ideal sería tener simetría tanto en planta como en elevación, aunque esta 

última pueda tener variantes mínimas, es decir que las plantas vallan variando o 

decreciendo y en general se  lleve a la estructura a una simulación piramidal 

muy suavizada. 

Cuando se tiene un edificio que parece asimétrico, es posible  que se tenga 

sistemas diseñados de tal manera que el edificio actúe dinámicamente de un 

modo simétrico, por lo tanto los núcleos de servicios probablemente están 

dispuestos asimétricamente dentro de una configuración simétrica, lo anterior 

se le llama falsa simetría, esto  para enfatizar que la simetría va más allá de la 

simple geometría. 

Otros aspectos: 

Aquí podemos mencionar distribución y concentración, es decir que en 

ciertos puntos del edificio quedan columnas más juntas y muchas veces del 

mismo tamaño típico, provocando una concentración de masa. 

También se tiene densidad de la estructura en planta, esto aplica cuando en 

una misma planta se tienen más columnas o elementos estructurales, y se 

puede considerar una consecuencia de la concentración debido a la distribución 

de elementos. 

Estos dos aspectos involucran un costo más alto para el edificio, además de 

considerarlo más estable sísmicamente, si se da en los primeros niveles, en 

caso contrario se convierte en un peligro por actuar como péndulo invertido. 

En general  se deberán tomar en cuenta todas estas condiciones o aspectos 

para mejorar la estructura considerablemente, en la práctica, muy raras veces 

ocurre o se tienen estas características que ayudarían a tener mejores 
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estructuras y más económicas, lo principal es el diseño arquitectónico, y por lo 

tanto es una responsabilidad de ingeniería estructural y arquitectónica, 

compartida, ya que el arquitecto define la funcionalidad, la cual debe aplicarse a 

lo estructural. 

En consecuencia la ingeniería estructural está centrando interés en que la 

forma, la simetría y la distribución general desarrolladas en la etapa conceptual, 

son muy importantes y contribuyen de manera más significativa en la 

determinación exacta de las fuerzas debido a los análisis y diseños  

Estructurales.  

Para el caso del edificio a analizar se tiene 

Edificio de apartamentos y oficinas Sur-Reforma 

Planta típica:         Es simétrica,  

Altura:                  Del nivel ingreso o nivel de calle, tiene 56.91 mts. 

Ancho menor:       Tiene 22.80 mts. 

Ancho mayor:       Tiene 26.50 mts. 

Relación Esbeltez: 22.8*4= 91.2 mts. altura máxima sin mayores       

Inconvenientes, como 56.91 < 85.3  ok 

                             56.91/22.80= 2.50,  considerado Bien. 

 

Distribución y Concentración:     

Por su forma, se considera normal, y tomando en cuenta     que es simétrica 

esto implica mínima torsión. 
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Conclusión:       

De los parámetros analizados, se tiene que es una planta simétrica, con 

entrantes y salientes simétricos, la torsión será mínima, además se deberá 

tomar en cuenta no crear un nivel débil, (nivel ingreso), quedando la estructura 

de marcos espaciales resistentes a momento. 

Con lo anterior se tienen las características propias del Edificio Sur Reforma, y 

así obtener los parámetros que nos servirán para los cálculos sísmicos. 

A continuación se presentaran los planos del proyecto: 

o Plano de sótanos típicos 

o Plano de lobby- 1er Nivel 

o Plano de oficinas 2do y 3er. Nivel 

o Plano típico de apartamentos 4to al 14vo. Nivel 

o Sección A-A 

o Sección B-B 
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FIGURA 2. Planta, típica de Sótano. 
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FIGURA 3. Planta, 1er Nivel- Lobby 
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FIGURA 4. Planta. 2do y 3er. Nivel 

 

FIGURA 5. Planta típica de 4to. Al 14vo. Nivel 



 

 

14 
 

 

FIGURA 6. Sección A-A 
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FIGURA 7. Sección B-B 
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2.2.- Documentación para análisis y diseño (Códigos a usar) 

Es la preparación de todos los documentos y gráficos necesarios que 

intervendrán en las diferentes etapas de análisis y diseño estructural,  y se 

aplicarán en predimencionamiento, así como en el proceso de modulación, se 

usara el programa de Etabs, que hacen posible una mayor precisión en la 

descripción de los fenómenos físicos. 

Los códigos de diseño y construcción, son propios de cada país y los aplican 

según parámetros desarrollados, los cuales están basados en estudios de 

escritorio, laboratorio y campo. 

En Guatemala es hasta el año de 1,996 que la Asociación Guatemalteca de 

Ingeniería Estructural –AGIES- pública la primera edición de las Normas 

Estructurales de Diseño y Construcción Recomendadas para la república de 

Guatemala. Entonces para nuestro caso normalmente se tiene lo siguiente: 

o Normas Estructurales de Diseño y Construcción recomendadas 

para la República de Guatemala. AGIES 

o International Building Code IBC-06 

o Reglamento de las construcciones de Concreto Reforzado 

ACI318-05 

o ASCE7/SEI 7-05 Minimum Design Loads for Buildings and 

Other Structures. 

Con estos códigos, los ingenieros estructurales los aplican con criterio para 

Guatemala, y específicamente el de AGIES, que para esta etapa será la de 

análisis estructural. 
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Para los diseños estructurales se aplicarán  

o Reglamento de las Construcciones de concreto Reforzado ACI318-05 

o International Building Code IBC-06 

o Teoría específica de vigas y columnas, por medio de software y 

programas específicos en hojas Excel. 

o La información de Etabs, debe coincidir con programas de hojas Excel. 

Esta información procesada y documentada se identificará así. 

Memoria descriptiva: aquí deberán estar las listas de normas o códigos a 

usar, descripción del procedimiento de análisis, acciones, vínculos, etc., 

además de que permita la interpretación de los aspectos analíticos del proyecto. 

Memoria de cálculo: deberán estar todos los resultados del análisis y 

diseño con su respectiva verificación, como la información de los programas es 

voluminosa, la misma se presente como anexo en las mismas. 

Con lo anterior no se pretende producir memorias extensas, sino completas y 

claras, es necesario  que  el anexo de cálculo se justifique razonablemente el 

cumplimiento de las condiciones que exigen a la estructura en su conjunto y 

cada una de las partes, esto con el objeto de garantizar la seguridad y el buen 

servicio de la estructura. 

2.3.- Definición y predimencionamiento de estructura. 

Para definir y predimensionar la estructura del edificio Sur-Reforma, un edificio 

de 14 niveles en concreto armado, se utilizaran los criterios del ACI318-05 y 

usando Etabs, con esto se pretende reunir los conceptos de ingeniería 

estructural antes expuesto, quedando recomendaciones para el análisis y 

diseño estructural para este tipo de estructuras. 
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Lo  importante es dejar claro el uso del Etabs, para análisis y diseño, y aceptar 

sugerencias y comentarios por parte del gremio de la ingeniería Estructural. 

Una estructura debe diseñarse para que tenga resistencia y rigidez adecuada 

ante las cargas designadas tales como: 

Carga muerta= CM, estructura propia y acción gravitacional.  

De Tabla C3-2 del ASCE 7-05 PÁG. 266. Se tiene: 

Concreto reforzado (armado)  = 150.0 lbs. /pie3 

Block típico edificio 50 kg/cm2  =   75.0 lbs. /pie3 

Mortero de acabados   =   93.0 lbs. /pie3 

Muro cortina de vidrio    =   112.0 lbs. /pie3 

Rellenos     =   80.0 lbs. /pie3 

Pisos y mezclas    = 110.0 lbs. /pie3 

Cielo falso     =     3.0 lbs. /pie2 

Instalaciones     =     2.0 lbs. /pie2 

Carga viva=   CV, por el uso y ocupación, utilizar las máximas. 

Tabla C4-1 del ASCE 7-05 PÁG. 274  se tiene: 

Cv= balcones, corredores, gradas, salidas de emergencia, lobby =  100 lbs. 

/pie2 

Cv= Habitaciones, apartamentos       =  40 lbs. /pie2 

Cv= Parqueos       =     50 lbs. /pie2 

Cv= Terrazas accesibles      =     40 lbs. /pie 
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Cv= Oficinas        =     50 lbs. /pie 

Carga sísmica= CS, se aplica código IBC-06, Tablas 3, 4,5 y AGIES 

Carga viento= CV, se aplica código IBC-06 

Esfuerzos en los materiales serán: 

F`c= 4,000 lbs. /plg2 

Fy= 60,000 lbs. /plg2 

Además se debe poner atención a efectos como cargas de impacto, cambios de 

temperatura y asentamientos, este último es una función que está ligada al 

estudio de suelos y geotécnico. 

En el  prediseño estructural,  se define, el sistema de piso, para nuestro caso 

será losa maciza o tradicional apoyada en vigas de los respectivos marcos, 

tanto en  sentido Números como Letra. 

Prediseño de Losa 

Se tienen dos opciones para el cálculo del espesor de losa, t= espesor de losa. 

Con un módulo típico para los sótanos  y entrepisos según planos definidos se 

tiene: 

Eje D-E/2-3     a=3.77 mts.     b = 4.25 mts. 

Opción 1: 

t= Perímetro/180  entonces se tiene: 

Eje D-E/2-3  t= (3.77+4.25)*2/180= 8.9 cms.  redondear a t=10. cms. 

Opción 2: 
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Se utiliza la ecuación 9.12 o 9.13 de ACI318-05,  según valor de α m   el cual 

según cálculos: 

α m  =    1.13   entonces se debe usar fórmula 9-13 del ACI308-05 

 

Dónde: 

ln= lado mayor= 425 mm 

fy= 60,000 psi, esfuerzo del refuerzo.= 420 MPa 

β = relación b/a= lado largo/lado corto= 4.25/3.77= 1.13 

α m= relación de rigidez =  según Cálculo =1.13  

t= 425(0.8+ 420/1500)/(36+9*1.13)= 11.02 mm  

Redondear a t= 12 cms. 

Entonces se deja  t= 12 cms. 

Pre diseño de vigas 

Para este prediseño tenemos: 

Opción 1: tabla 9.5(a) 
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Notes:

Vallues given shall be used directly for member 

wiht normal weight concrete ( wc=145 lbs/ft3) an 

grade 60 reinforcement for other conditions, the 

values shall be modifified as follows

a) For structural lightweight concrete having unit 

weight, wc, in the range 90-120 lbs/ft3, the 

values shall be multiplied by (1.65-0.005wc) but 

not less than 1.09

b) For fy other than 60,000 psi, the values shall 

be multiplied by (0.4+fy/100,000)

Members not supporting or attached to 

partitions or other construction likely 

be damaged by large deflections.Member

Solid one- 

way slabs

Beams or 

ribbed one-

way slabs

l/20 l/24 l/28 l/10

l/16 l/18.5 l/21 l/8

TABLE 9.5 (a) MINIMUN THCKNESS OF 

NONPRESTRESSED BEAMS OR ONE-WAY SALBS

UNLESS DEFLECTIONS ARE CALCULATED

Minimun thickness, h

Simply 

suppted

One end 

continuous

Both ends 

continuou

s

Cantaliver

 

FIGURA 8.  Peraltes Mínimos ACI318.05 

Luz típica 8.50 mts. y 7.50 mts. 

Entonces se tiene l/21= 8.50/21= 40.0 cms.  

Opción 2: aplica siguiente criterio 

 8% de la luz h= 8.5*0.08= 0.68 mts.= 70 cms. 

Opción 3: aplica siguiente criterio 

Luz/12= 8.50/12 =0.708 mts. = 70 cms. 

Entonces se toma la mayor y se redondea,  lo cual nos da h=0.70 mts. y 

asumimos una relación 2:1 su base es b=0.35 mts.  Quedando definida la viga 

de  b=0.30-0.40, y para efectos de prediseño b=0.35 y h#= 0.70 y 

hletras=0.70después de primera corrida estructural se corrigen estos datos según 

requerimiento. 
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Pre diseño de Columnas 

Se debe tener integrada la carga de losas y esta queda así. 

ENTREPISO
CASO TIPICO

CARGA MUERTA cms pcf Lbs/pie2

Losa Trad. 0.12 150 59.0

Relleno G. 0.00 80 0.0

Pisos y mezcla 0.06 110 21.65

Repellos cielos 0.02 80 5.25

Otros, instalaciones  2.00

Wcm= 87.94

Wcm=SCM=Etabas o Sap 28.90

CARGA VIVA

1 VIVIENDA / APARTAMENTOS (1) Wcv= 40.00

2 Oficinas  (2) Wcv= 50.00

3 Balcones, Corredores y gradas (3) Wcv= 100.00

TOTAL CARGA TRABAJO Wct1= 127.94

Wct2= 137.94

  Wct3= 187.94

Carga Ultima Wcu1= 169.52 lbs/pie2

Wcu2= 208.11 lbs/pie3

Wcu3= 293.11 lbs/pie3

CASO TIPICO

CARGA MUERTA cms/metros pcf Lbs/pie2

Losa Trad. 0.12 150 59.04

Desniv + mescla 0.050 80 13.12

Baldosa B. 1/2 0.055 105 18.94

Repellos cielos 0.020 80 5.25

Wcmt= 96.35

Wcm=SCM=Etabas o Sap 37.31

CARGA VIVA

TECHO  ACCESIBLE Wcv= 40.00

TOTAL CARGA TRABAJO

Wct= 136.35

Carga Ultima Wcu= 115.62 lbs/pie2

T E C H O S 

 

Tabla I. Integración de Cargas 

Opción 1: aplica siguiente criterio 

 Que bxd ≥  P/Φ f´c 
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Tendremos f´c= 4,000 psi, valor de Φ= 0.3 y el valor estimado de P, en este 

caso tomamos una área típica para columna en eje D/3 el cual nos da un área 

de 7.125x8.50=60.56 mts.2= 652 pies2 (se aproxima) 

14 niveles de entrepiso: Tenemos              652x179.62x1    =   117,112.2 

lbs. 

           652x185.52x2 =      241,918.0 lbs. 

652x169.52x11= 1, 215,797.5 

lbs. 

4 niveles de sótano                        652x169.52x4 =     442,108.2 lbs. 

 Peso total de losas            2,016,935.9 lbs. = 2,016.9 kips 

Peso de vigas (8.5+7)x0.35x0.70x3.28^3x150x18= 361,812.0 lbs. =    361.8 

kips 

Peso de Col. estimado (1x1)x3.70x3.28^3x150x18= 352,522.6 lbs. =  352.5 

kips 

Teniendo un peso total para una columna típica de                  = P= 2731.3 kips 

 Que es aproximadamente equivalente a un peso total de   P= 1,241.5 ton.  

Aplicando la fórmula tenemos. 

100x100≥2,731.3/0.3x4000 →10,000 ≥2,276.0. ok, 

Por lo tanto asumir esta medida por motivos de momentos y sismo, además de 

tener medidas degradadas hasta 70x70. 

Resumen 

Losa t= 12 cms  
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Vigas Principales Números     b=0.35   h= 0.70,  

Principales Letras   b=0.35   h= 0.70, 

Secundarias Letras   b=0.25    h=0.50 

Secundarias Números  b=0.25    h=0.50 

Columnas                 b=1.00    h=1.00 

La ampliación o reducción de las secciones se verificara hasta en el primera 

corrida de análisis estructural y siguiendo las especificaciones del ACI318-05. 
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CAPÍTULO 3 

Análisis Estructural, conEtabs9.5 

3.1- Proyecto definido. 

 

El edificio proyectado: Sur-Reforma 

Ubicación:    Av. Las Américas  3-17 zona 14  

Sótanos:   Cinco sótanos. 

Niveles 1:   Lobby 

Nivel 2 y 3:   Oficinas 

Nivel 4 al 14:   Apartamentos 

Tipo estructura:  Marcos espaciales resistentes a Momento. 

Material:   Concreto reforzado 

Lado menor:   22.80 mts. 

Lado mayor:   26.50 mts. 

Altura a partir de acera: 56.91 mts. 

Área de construcción: 16,499.00 mts.2,  

Planta típica:   Simétrica 

Elevación típica:  Simétrica 
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3.2- Integración de cargas y dimensionamiento de elementos. 

De la integración de cargas, se identifican así: CM, Cv, ScM.  

ENTREPISO
CASO TIPICO

CARGA MUERTA cms pcf Lbs/pie2

Losa Trad. 0.12 150 59.0

Relleno G. 0.00 80 0.0

Pisos y mezcla 0.06 110 21.65

Repellos cielos 0.02 80 5.25

Otros, instalaciones  2.00

Wcm= 87.94

Wcm=SCM=Etabas o Sap 28.90

CARGA VIVA

1 VIVIENDA / APARTAMENTOS (1) Wcv= 40.00

2 Oficinas  (2) Wcv= 50.00

3 Balcones, Corredores y gradas (3) Wcv= 100.00

TOTAL CARGA TRABAJO Wct1= 127.94

Wct2= 137.94

  Wct3= 187.94

Carga Ultima Wcu1= 169.52 lbs/pie2

Wcu2= 208.11 lbs/pie3

Wcu3= 293.11 lbs/pie3

CASO TIPICO

CARGA MUERTA cms/metros pcf Lbs/pie2

Losa Trad. 0.12 150 59.04

Desniv + mescla 0.050 80 13.12

Baldosa B. 1/2 0.055 105 18.94

Repellos cielos 0.020 80 5.25

Wcmt= 96.35

Wcm=SCM=Etabas o Sap 37.31

CARGA VIVA

TECHO  ACCESIBLE Wcv= 40.00

TOTAL CARGA TRABAJO

Wct= 136.35

Carga Ultima Wcu= 115.62 lbs/pie2

T E C H O S 

 

Tabla I. Integración de Cargas 

Ya definida la integración se procede a introducir las cargas, y su verificación se 

realiza así: 
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Se tomará un Nivel típico para chequear y verificar la distribución de cargas. 

 

FIGURA 9. Planta distribución cargas 

De la anterior se procederá a calcular carga de losas en eje 3/D-E y D/3-4, 

teniendo los cálculos y medidas siguientes: 

Losa 1   ejes 2-3/D-E  a=7.55/2=3.775mts..   b= 8.50/2=  4.25 

Losa 2   ejes 3-4/D-E  a=6.70/2=3.35 mts..   b= 8.50/2=  4.25 por áreas 

tributarias. 

Este cuadrante de losa se 

chequeará la distribución de 

carga viva y muerta.  

a=3.775 mts. y b=4.25 mts. 

Este cuadrante de losa 

se chequeará la 

distribución de carga 

viva y muerta.  

a=3.35 mts. Y b=4.25 

mts. 
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losa mts pies

a 3.78 12.40 m 0.89

b 4.25 13.94

lbs/pie2

Carga de triangulo doble 247.97 lbs/pie2 Cv 40.00

base 3.78 Area Triangualo 3.57 mts2

altura 1.89 38.43 pies2

W1tiangulo 123.984 lbs/pie

lbs/pie2

Carga areaTrapecio doble 275.39 lbs/pie2 Cv 40.00

base 1 4.25 Area 4.46 mts2

base 2 0.47 47.99 pies2

altura 1.89

W1trapecio 137.695 lbs/pie

lado corto ws/4 123.984

lado largo ws/4(2-m) 137.70

Comprobacion por formula, tambien 

coincide

Calculo de cargas a vigas por Areas tributarias

CARGA VIVA

 

Tabla II. Cálculo de cargas a vigas 

Con secuencia-●Marcar losa>Click derecho► En ventana, verifica cargas 

admitidas, que en nuestro caso son Cv=40 lbs. /pie2 y SCD=37.31 lbs. /pie2 

(SCD=sobrecargas muertas, ver integración de cargas) 
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Luego con secuencia -●Display>Show loads► frame/line, y en ventana se 

elige la carga requerida (Live, Dead, Scdead) y aparece distribución triangular y 

trapezoidal 

 

Realizar un acercamiento para, Caso corto eje C, con doble carga de área 

triangular en carga viva 

 

Etabs da un valor triangular de 495.41 lbs. /pie, como valor máximo en una 

carga triangular, para convertirla en distributivamente se realiza lo siguiente: 

Wcv= (0+495.42)/2=247.705 lbs. /pie y el dato calculado en hojas Excel nos da 

Wcv= 247.97  lbs. /pie, con lo cual se verifica que la integración manual y la del 

programa Etabs, coinciden. 
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De igual forma se procede  resto de cargas con la carga muerta, para esta caso 

se considera la calculada por Etabs, que sería la losa y la viga correspondiente, 

lo referido a sobrecarga se hace igual y por aparte, y si uno quiere saber toda la 

carga muerta se deberá sumar la Cdead y Scdead (Cmuerta y Sobrecarga 

muerta=Carga muerta total), entonces se verificara la Cdead. 

 

Wcm= (0+731.36)/2=365.68.Lbs. /pie y el dato calculado en hojas Excel nos da 

Wcm= 365.52  lbs. /pie, y nuevamente se verifica que la integración manual y la 

del programa Etabs, coinciden. 
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El dimensionamiento de elementos se rectifica con las siguientes medidas. 

Columnas:     1.00x1.00 mts.. Hasta 50x50 

Vigas Principales  0.35x0.70 mts. 

Vigas secundarias:  0.25x0.50 mts.. 

Losas tradicionales:  0.12 mts.. 

Al tener estas medidas definidas, se usaran para el modelaje de la estructura 

tridimensional, la cual se ajustara después del primer análisis, en Etabs donde 

solamente se integrara la Cm, Cv, Csismo (estático). 

3.3- Modelación de Geometría y cargas gravitacionales. 

En esta fase donde se inicia a modelar la estructura del proyecto, para nuestro 

caso el edificio Reforma-Sur se toma la información resumida anterior. 

Se comenzará con etabs9.5 y se irá explicando paso a paso la forma de esta 

primera parte como lo es la Geometría y cargas gravitaciones. 

Definir las dimensionales a usar, estas se ubican en la parte inferior derecha de 

Etabs9.5,  y cuando se elige una dimensional, la misma no varía, aun  cuando 

se cierra y luego se abre  nuevamente el archivo. 

Con respecto a las dimensionales,  la elegida inicialmente se mantiene,  pero 

conforme se introducen más datos uno puede ir cambiando según 

requerimiento, por ejemplo, para el edificio iniciamos con kips-pie, y luego 

cambiamos a kg-mts..  Ya que al introducir la geometría, es mejor trabajar 

metros porque se hace más fácil y comprensible, pero cuando creamos un 

material, la dimensional a usar es en lbs.-pulg, porque  se visualiza mejor los 

datos de, Fc= 4,000 psi, fy= 60,000 psi. 
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Los  pasos de introducción de datos, como geometría y cargas, se realizaran de 

la siguiente manera: 

 Se dará la secuencia escrita en negrilla  

Continúa con la gráfica correspondiente por el programa. 

 Además de una explicación adicional para su mejor comprensión. 

INICIO DE PROGRAMA, MODELANDO ESPACIOS Y NIVELES. 

File>New Model► elige No, en ventana. 

 

El primero (choose.edb) se puede elegir si se tienen archivos similares creados 

con anterioridad, el segundo (Default.edb) puede ser un archivo por default que 

trae el programa y pueda aplicarse al que uno quiere, y el tercero, (No), se 

recomienda elegir, ya que se crea el modelo según planos. En la ventana 

siguiente, se deben introducir los datos de ejes en X (6) y  Y (6) y editar la 

misma, para el plano y elevación respectivamente. 
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● Custom grid spacing► Grid labels: se editan dónde van ejes Letras 

(spacingX) y Números (spacing Y) y su forma de iniciar, puede ser de  izq-

derecha  y  abajo-arriba, según planos, o viceversa, al  final ok. 

Custongridspacing 

Gridlabes 
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●Edit grid► cambiar a kg-mts., y  en Display grids as►      ●spacing: 

Esta forma de ingresar distancias entre ejes, es decir distancia de Eje A a Eje B 

(Eje X, 7.05-7.55 - 6.70 – 7.55 – 7.05- Eje Y 6.15 – 8.50 -8.50…) conforme 

planos definidos, además se recomienda colocar un color al eje 1 y A, para 

visualizar que todo está conforme los planos. Para agrandar ejes, se cambia el 

número en ●Bubble size, y ok 

Editgrid 

Elige Spacing antes 

de ingresar datos 

Bubblesi

ze 
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●Custom story Height► aquí se editan alturas, se inicia colocando la cota 

inicial en elevación y después las alturas respectivas de sótanos y niveles, se 

elige nivel  masters (Nivel 14, cualquier cambio en este lo realiza en los 

similares), además se edita  la columna Label, ejemplo sótano 4, nivel 1-  o 

según requerimiento. 

Después Ok, Ok, y aparece la ventana siguiente, que define el espacio del 

edificio en planta y tridimensional. 

 

Aquí puede verse que se fue cambiando las dimensionales según 

requerimiento, pero aquí aparece la elegida (kip-pie), además puede verse que 

aparece el nombre de la planta y su elevación como se ingresó anteriormente. 

Editan datos de Nivel, 

altura a conveniencia 
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Si por algún motivo se debe corregir algún dato se ubica el cursor en pantalla y 

clik derecho, donde se edita cualquier dato erróneo o agregar información extra. 

 

Otra forma de editar es     edit► y elegir de la ventana Grid data (planta) Story 

data (Niveles)  Reference plane (Planos de referencia, planos auxiliares), 

reference line (líneas de referencia) se usan en los sótanos. 
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DEFINIENDO PROPIEDADES DE MATERIALES 

 ●Define► Material Properties, Define el material a usar, F´c= 4.000 psi, 

siguiendo ►Add New Material ● verificar F´c=4ksi,  fy=60 ksi.  Ok, Ok. 

 

Luego se cambia dimensional de lbs.-pie para verificar peso volumétrico de 

concreto (150 lbs. /pie³) y masa por unidad volumen que será W/g. (150/32.20= 

4.6573). El modulo de elasticidad concreto calculado así wc^1.5x0.043xҐf´c 

(Mpa)=3.85E06 (psi) corroborando que los valores descritos en Define son 

iguales a los calculados. Ok, Ok. 

Peso especifico 

150lbs/pie3 

Nombre concreto= 

concreto4 

Masa por unidad 

volumen ok 
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De igual forma se pueden modificar o eliminar cualquier material según 

requerimiento. Como puede verse es necesario siempre verificar todos los 

datos que aparecen en las ventanas, porque si se crea otro concreto por citar 

otro ejemplo, los datos no cambian y uno debe calcularlos y cambiarlos 

manualmente. 
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DEFINIENDO SECCIONES DE ELEMENTOS. 

COLUMNAS 

 ●Define►frame section, en define frame propertis se elige ▼add 

rectangular, en Rectangular section, se etiqueta Col1x1, CON4000, Ingresa 

medidas Depth (3) 1, Width (2) 1, y finaliza ejecutando ►Reinforcement donde 

se etiqueta ●column, ●Rectangular ●Ties (estribos), además indicar 

recubrimiento (0.045 mts.) y decidir si el programa Calcule el refuerzo o si debe 

Chequear el refuerzo asignado, se aconseja que el programa lo diseñe. 

 

De igual forma se procede a otros elementos de columnas que se crearan para  

sótanos (COL40X80), (COL90X90), (COL 80X80), (COL70X70). 

Aquí recubrimiento 

según ACI 

Define columna o viga 

Refuerzo calcule programa  o 

hacer chequeado según 

requerimiento. 
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VIGAS 

●Define►frame section, en define frame propertis se elige ▼add 

rectangular, en Rectangular section, se etiqueta Viga35x70, CON4000, Ingresa 

medidas Depth (3) 0.70, Width (2) 0.35, y finaliza ejecutando ►Reinforcement 

donde se etiqueta ●Viga, el refuerzo se explicara a detalle cuando se pase al 

diseño. 

 

Coloca ref. Calculado según 

diseño y se explicara a detalle 

cuando se esté en la etapa de 

DISEÑO. 

Recubrimiento 
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LOSAS O MUROS 

●Define►Wall /slab/deck section, seguido ●add new slab, se edita 

nombre losa=LOSA12, CON4000, membrane y bending= 0.12, finalmente 

●Membrana. 

 

Mismo criterio para definir un muro de concreto  o deck. 

Si la losa trabaja en 

un sentido → aplica 

esto. 

Aplica Membrana, porque 

distribuye las cargas 

triangulares y trapezoidales. 

Nombre de losa 
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MODELO GEOMÉTRICO ESTRUCTURAL TRIDIMENSIONAL 

●Draw►Draw linea objects/Create Columns-in-región o usando 

ícono.Aquí se inicia con columnas, sigue vigas, losas y muros según diseño de  

Planos

 

 

Usa Icono Col 

Al indicar similar story, 

van apareciendo en 3D, 

columnas en Negro. 

Elige elemento definido y 

se va marcando donde lo 

indica el plano 
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De igual forma se procede para vigas, losas, o muros, siguiendo la secuencia o 

usando íconos. 

●Draw►Drawline objects /CreateLines-in-región o usando ícono. 

Con este ícono se dibujan las vigas, se busca la definida, y es por áreas o 

líneas  para ciertos puntos específicos donde no aplica región. 

 

De igual forma se modelan col. 

Secundarias en sótanos, aquí es por 

Onestory y se realizan por sótano. Y se 

va formando la estructura en 3D. 

Icono vigas 

principales. 
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Como puede verse se eligen áreas con cursor del mouse, y se van formando 

los marcos espaciales a momento, a su vez se va desarrollando el modelo en 

3D. Para el área de sótanos se debe trabajar con elevaciones e ir modelando 

las rampas y/o desniveles requeridos por el diseño arquitectónico, se realiza un 

eje típico de rampa y luego se replican a otros ejes, esto con la finalidad de 
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facilitar y que rampas sean idénticas, y con secuencia se procede a replicar lo 

indicado: ●Edit►Replicate - ventana y elige Linear, se coloca la distancia  X 

o Y respectiva, (negativa o positiva) y si se requiere borrar los elementos origen 

se marca Delete original, caso contrario no se marca, que es nuestro caso. 

 

Ahora que está definida la estructura  general como se puede visualizar así: 
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Para dibujar losas se  hace lo siguiente: 

●Draw►Draw area objects-Draw Areas (Plan, Elevation, 3D), o ícono.  Esta 

secuencia nos deja dibujar las losas, y al colocar en modo similar se dibujan 

todas las losas en los niveles similares. 

 

Antes de esto se procede a definir los voladizos, muros de gradas y ducto de 

elevadores procediendo a dibujar puntos de referencia y con la siguiente 
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secuencia. Draw►Draw Reference Point y ventana Properties of Object se 

van eligiendo los ptos. Requeridos según diseño de voladizos, muros, etc. 

 

 

Ya definidos los ptos. de perímetro de losa y ubicación de muros, gradas y 

ductos, que es la gráfica anterior terminada. 

Ptos. de referencia para  

dibujar voladizos 

Ptos. de referencia  

dibujados. 
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Luego se sigue con secuencia Draw►Draw área objects-Draw Áreas (Plan, 

Elevation, 3D), para voladizoso Ícono, y con ventana de properties of Object, 

se elige la losa12, que es la definida con anterioridad y cumpliendo los 

requerimientos ACI318-05. 

 

Ícono de losa o muros 

Elige losa 12 
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También se van definiendo las vigas en voladizo, estas se van dibujando con el 

criterio anterior y secuencia Draw►Draw line objects-Draw Lines (Plan, 

Elevation, 3D), esta opción dibuja una por una, según requerimiento 

estructural. 

 Además al ir modelando losas por separado es ideal unir las mismas eligiendo 

dos losas y  la secuencia Edit►Merge áreas, hasta dejar una sola losa. 

 

Aquí se ubica en nivel Techo para después copiar el resto de niveles. 
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Lo ideal desarrollar por completo este nivel con losas, muros, vigas voladizo, 

vigas secundarias, ductos, etc. Y después copiar al  resto de niveles. 

Para dibujar los  ductos en losas se procede así. Draw►Draw área objects – 

draw Área (Plan, Elevation, 3D), y en ventana se elige (OPENING), seguido 

de los muros Draw►Draw área objects – draw Walls (Plan) 

 

 

Elige Opening 

Se pueden dibujar muros o 

agregar la carga distribuida 
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Y luego dibujando según requerimiento estructural, las vigas secundarias y 

muros. 

 

Finalmente queda terminado el nivel y se pueden apreciar los muros definidos. 

Visualiza losa  y muros 

terminados 
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Para poder copiar a los otros niveles, se continua con de la secuencia 

Select►By frame sections o by Wall/slab/Deck section, y se eligen, vigas, 

losas y muros requeridos, seguido de Edit►Replicate►Story, y se eligen los 

niveles donde se quiere que se copie y ok. 

 

 

Importante no marcar Delete Original, porque si no se borra el nivel base 

(techo) 

Eligen niveles a donde se desea copiar, 

losa, vigas y muros. 
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Para los siguientes niveles pendientes que no son iguales, lo ideal es seguir  

trabajando con un solo nivel. Luego con  las losas de rampas y sótanos se 

realizan por nivel, y se deben armar en el 3D, ya que en planta no se pueden, 

para lo cual se deben marcar las vigas correspondientes a las rampas y con 

click derecho se selecciona ►Wiew selected objects only  quedando así: 

Se visualizan las vigas seleccionadas únicamente y se procede con la 

geometría de losa, que se hace más fácil realizarla, caso contrario no se dibujan 

correctamente y aparecen demasiados Warning. 
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La losa queda inclinada según requerimiento y se procede con vigas 

secundarias, de igual forma se continúa con resto de rampas. 

Aquí el modelo está completo y se pueden visualizar las rampas y niveles 

terminados y para estar seguro se procede a ser un chequeo de la geometría. 
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Con secuencia Analize►By Check Model y ventana se eligen: Primero: Line 

check:  

 

Segundo: Point check, tercero: Área check y finalmente meshing, el último 

loading for all stories, hasta cuándo se han introducido las cargas.  Al final debe 

aparecer un mensaje de cero advertencias, indica ok. 

 

Indica que No se tienen 

advertencias, 

considerando bien el 

modelaje. 

Ideal ir eligiendo uno 

por uno los ítems y 

que verifique, es más 

fácil saber donde 

puede estar  el error. 
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DEFINIENDO CARGAS GRAVITACIONALES A MODELO ESTRUCTURAL 

TRIDIMENSIONAL 

Cuando se comienza con  cargas, se inicia definiéndolas con la siguiente 

secuencia: ●Define►static Loads Cases, 

 

En ventana se definen todos los casos a usar, que son. 

Dead SU FACTOR  ES 1, porque el programa automáticamente agrega la 

carga correspondiente  a los elementos definidos con anterioridad, siguen Live, 

Scdead y Sismo en la segunda ventana, se definen los parámetros según 

IBC03. 

Todos los parámetros se deben 

ingresar a requerimientos de IBC 

seleccionado, o calcular  el factor. 

Definen:  Dead, (1) 

Live, sismo (0) 



 

 

57 
 

Definiendo cargas y sobrecargas 

Entrepiso 

Wcm= 87.94

Wcm=SCM=Etabas o Sap 28.90

CARGA VIVA

1 VIVIENDA / APARTAMENTOS (1) Wcv= 40.00

2 Oficinas  (2) Wcv= 50.00

3 Balcones, Corredores y gradas (3) Wcv= 100.00  

Techo 

Wcmt= 96.35

Wcm=SCM=Etabas o Sap 37.31

CARGA VIVA

TECHO  ACCESIBLE Wcv= 40.00

 

Tabla III. Cálculo de cargas y sobrecargas 

Carga Viva, 

Primero se elige el área y luego secuencia Assign►shell/área Loads→Uniform, 

si se tienen losas similares se elige y automáticamente se introducen las cargas 

a todas las losas similares, esto es de gran ayuda cuando se tienen varios 

niveles. 

 

Esto nos asegura que la carga 

asignada será siempre la 

misma, aunque exista otra. 

Si hay losas iguales y su 

carga también se elige 

similar stories 
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Carga muerta de sobrecarga, en ventana se elige Live, Lbs. /pie, gravity, 

Repleace existing Loads y finalmente la cantidad de carga viva calculada, se 

procede igual con Sobrecarga= Scdead= (sobrecarga muerta), que será la parte 

que no integra el programa. 

 

 

 

 

 

 

 

 

Cantidad correspondiente a 

SCD= sobrecarga muerta. De 

Igual forma carga Live. 
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3.3- Modelación  e integración de cargas de Sismo (estático y   

Dinámico 

Para sismo Estático  corresponde según IBC-06 y AGIES así: 

CODIGOS

Paso 1 Clasificacion de estructura  de tabla 1604.5

Categoria III

Factor sismico 1,25

Factor de viento 1,15

Paso 2 Parametros de aceleracion del suelo:

Valores asumidos, pero deben aplicar según

estudio geologico, de suelos y mapeos.

S1= 0,75

SS= 1,25

Paso 3 Tipo de suelo, clasificacion según tabla 1613.5.2

Sitio D

Paso 4 Coeficientes Fa y Fv de tabla 1613.5.3(1) y (2)

Coeficiente Fa

Fa= 1,00

Coeficiente Fv

Fv= 1,50

Paso 5 Coeficientes  para el maximo simo esperado

con formulas seccion 1613.5.3

SMS=Fa Ss= 1,25

SM1=Fv S1= 1,13

Paso 6 Parámetros de aceleración espectral

con formulas seccion 1613.5.4

SDS=2/3 SMS= 0,83

SD1=2/3 SM1= 0,75

Paso 7 Períodos de control 

To=0.2 SD1/SDS= 0,18 seg

Ts= SD1/SDS= 0,90 seg

T= Periodo F. 1,65 seg

T= Ct*hn
x

ct 0,02

hn 52,80 mts

173,18 pies

x 0,90

Paso 8 Sistema estructural de tabla 12.2.1 ASCE7

y coeficientes y factores sismicos

C5 Marcos especiales resistenes a momento

R= 8,00

Cd= 5,50

Ωo= 3,00

Paso 9 Corte Basal

V=  (1.20Sds/R)*W 0,1250 *W

W= peso total carga muerta

INTEGRACIÓN DE LA CARGA SÍSMICA

IBC 2006/  ASCE-7-05

 

Tabla IV. Definición y cálculo de factores sísmicos, IBC-06 
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CODIGOS

Paso 1 Indice de sismicidad

Según mapa de Macrozonas

Io.= 4,00

Paso 2 Nivel de proteccion

Ver tabla 4,1

basado en tipo obra y considerada Ordinaria

Teniendo:

Io= 4,00

Clase obra= Ordinaria

Nivel de proteccion D

Paso 3 Definir tipo se sismo

Según requerimientos anteriores aplica D

Sismo basico 10% probabilidad de

 exceder en 50 años

aplica solo a obra ordinaria

Paso 4 Selección de parametros Iniciales

Coeficiente Scr y S1r Anexo 1

Scr= 1,50

S1r= 0,55

Paso 5 Ajuste por clase de sitio

Valores de Fa y Fv según tablas 4-2 y 4-3

Fa= 1,00

Fv= 1,50

ScS=Scr*Fa= 1,50

S1s=S1r*Fv = 0,83

Paso 5 Espectro calibrado

Valor del Factor de escala  Kd 0,66

Scd=Kd*Scs 0,99

S1d=Kd*S1s 0,54

Paso 6 Períodos Fundamental Ta

Ta=Kt(Hn)x 0,96 seg

Kt= 0,05

X= 0,75 seg

hn 52,80 mts

173,18 pies

Paso 7 Calculo de ordenas espectrales

con formulas 4-6 a y 4-6b

Sa(T)=Scd      si T ≤ Ts 0,99

Sa(T)=S1d      si T > Ts No aplica

Paso 8 Coeficiente sismico Cs

Cs= Sa(T)/R 0,12
Sa(T)=Scd      si T ≤ Ts 0,99

R de tabla 1-1 y sistema estructural 8,00

Cd de tabla 1-1 5,50

Ωo  de tabla 1-1 3,00

Cs≥ 0,044 Scd /R 0,0054

Cs≥ 0,5 S1r/R 0,0344

Ok cumple

Paso 9 Corte basal

VB=Cs*Ws 0,1238 Ws

INTEGRACIÓN DE LA CARGA SÍSMICA

AGIES

 

Tabla V. Definición y cálculo de factores sísmicos, AGIES 
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Como se puede visualizar en tablas IV y V se desarrolló en Excel, y siguiendo 

todos los parámetros del código IBC06 y AGIES, es valor correspondiente al 

factor sísmico aplicado es relativamente el mismo (0.1250) W, o (0.1238) W,  al 

calcular estos esto factores, por dos códigos diferentes, nos da la certeza del 

valor y tranquilidad, además de descartar que el programa lo realice todo y 

crear una caja negra donde no se tendrá control de estos parámetros. 

Luego se procede con carga sísmica estática, con secuencia de opción 1 

Define►Estatic Load cases→Ventana 1►SX→Elige código-IBC06- (4ta 

col.)seguido►Add New Load→Modify Lateral load● Ventana 2►Ingresan todos 

los datos calculados 

 

Se deben verificar para todos los 

casos de sismo creados, y aplicar 

conforme directtion and 

Eccentricity,  además de todos 

los otros parámetros dispuestos 

en esta ventana. 



 

 

62 
 

La opción 2,  se debe seguirDefine►Estatic Load cases→Ventana 1►SX→ 

Elige coeficiente (4ta col.) elegir►User coeficient→Add New Load→Modify 

Lateral load● Ventana 2►Ingresadato calculado igual a 0.13 

 

Para asignar la masa para el cálculo de corte, con secuencia Define►Mass 

Sourse→ Ventana 1►From loads►Cdead-1, CLive-0.20 (caso especial) 

 

Este valor de coeficiente debe dar los 

mismos resultados que si se usa 

código IBC06, las dos formas son 

válidas. 

Factores de 

cargas: Dead, 

Scd y Live 
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Con secuencia Define►Special seismic loads effects→ Ventana 1►se 

introducen datos según IBC 06 sección 1617.2, ya calculados anteriormente. 

 

Esta fase estructural, donde se aplica el sismo estático, se debe tener cuidado 

el ingreso de todos los datos ya sea por AGIES o IBC.06 para evitar errores. 
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Concluida la modelación de cargas sísmicas estáticas, se proceder a correr el 

modelo nuevamente, (2da vez.) y verificar si son lógicos sus momentos. 

 

Se visualiza que son lógicos, en nuestro caso  Marcos especiales resistentes a 

momento. Si el Análisis se hubiera elegido para, Marcos y Muros de corte, 

entonces  se deben corregir los parámetros sísmicos para nuestro caso que son 

marcos especiales resistentes a momentos, entonces los muros se deben 
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eliminar y se procede a calcular manualmente el peso distribuido en vigas que 

soportaran los muros de mampostería y fachadas, los cuales quedan así. 

Para el calculo de la carga distribuida en vigas 

de  ducto de elevador, vigas gradas y fachadas 

se procede asi:

Muro mamposteria 0.20 mts

Muro cortina (vidrio) 0.02 mts

Peso Promedio Elevador 3960.00 lbs

Peso final por codigo (+100%) 7920.00 lbs

Altura de piso a piso 3.70 mts

Peralte viga principal 0.70 mts

Altura promedio muro 3.00 mts

Altura promedio cortina (ventana) 1.50 mts

Altura promedio muro sillar (ventana) 1.50 mts

Peso especifico mamposteria 75.00 lbs/pie3

Peso especifico muro cortina 112.00 lbs/pie3

Cargas distribuidas

Wmuro mamposteria 484.13 lbs/pie

Wmuro cortina 36.15 lbs/pie

Wmuro mamposteria sillar 242.06 lbs/pie

Wmuro cortina+sillar 278.21 lbs/pie

Longitud  viga en elevadores 6.70 mts

Longitud total de viga 13.40 mts

Wcarga elevador 180.20 lbs/pie

Welevador + muro 664.32 lbs/pie

CALCULO DE CARGAS DISTRIBUIDAS

 

TABLA VI. Cálculo de cargas distribuidas. 

Estos valores se deben ir agregando en vigas correspondientes de la siguiente 

forma y secuencia. 
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Elige viga►assign►Frame loads distributed→Ventana 1►se introducen 

valor calculado anteriormente y correspondiente a viga que carga muro 

fachada,  ducto elevador o  gradas. 

 

Y así sucesivamente se introducen siguientes valores. Ya definidas las cargas 

nuevamente se corre (3ra. Corrida) y verifica que esfuerzos sean lógicos. 

Al 

revisar los diagramas de momentos para carga muerta y sismo Sx, se visualiza 

que el Análisis estructurales muy lógico.  

En carga distribuida se 

ingresa valor calculado 
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Se sigue con modelo de Sismo dinámico de la siguiente forma: Elige 

Define►Response spectrum Funtions►→Ventana 1►Código→Add New 

Functions 

 

►2da. ventana→ Nombrar espectro ►seguido de Convertto user defined, 

Esto garantiza que automáticamente queda ligado y grabado este espectro, al 

modelo realizado. 

Busca código IBC-06 

y agregar. 

Nombrar 

espectro. 

Convertir el uso 

definido 
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Con espectro se procede asignarlo así: Define►Response spectrum 

cases►→Ventana 1►Add New spectrum► Nombra  spectro y asigna. 

 

Las propiedades dinámicas de los modos de vibración de una estructura, es 

una opción que permite analizar los problemas dinámicos, y se utiliza para 

combinar las respuestas modales en el análisis del espectro de respuesta y 

también definir un valor de amortiguación.  

Nombrar 

espectro 

ESPOSA 

Parámetro según criterio  del 

Estructural, recomienda CQC.  

Por ser la que aplica a nuestro 

medio. 

Sx=1  y Sy =0.30 

significa aplicación de 

sismo en X y Y 

respectivamente 
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Las siguientes opciones están disponibles para combinaciones:  

CQC= Complete cuadratic combination, ►CQC modal: este es el método de 

combinación cuadrática completa descrito por Wilson, Kiureghian y Bayo 

(1981). Esta técnica de combinación modal tiene en cuenta el estadístico 

acoplamiento entre modos espaciados por amortiguación modal. Si la 

amortiguación modal es 0 para todos los modos, el método CQC degenera al 

método SRSS. Además trata convenientemente el caso de períodos-próximos, 

por lo que se recomienda. 

SRSS=Square Root of the Sum of the Squares method ►SRSS, Esta es la raíz 

cuadrada de la suma del método plazas. Esta técnica de combinación modal no 

tiene en cuenta cualquier acoplamiento de modos como los métodos CQC y 

GMC. 

ABS=the Absolute method►Este es el método absoluto. Esta técnica de 

combinación modal simplemente combina los resultados modales tomando la 

suma de sus valores absolutos. Este método es generalmente el más 

conservador. 

GMC= General Modal Combination method► Éste es el método de 

combinación Modal General que es también conocido como el método Gupta. 

Este método es el mismo que la combinación modal completo se describe en la 

ecuación 3,31 en Gupta (1990). El método GMC tiene en cuenta el estadístico 

acoplamiento entre modos espaciados similares al método CQC, y también 

incluye la correlación entre los modos con contenido de respuesta rígida. El 

método GMC requiere especificar dos frecuencias, f1 y f2. 

Referente a los diafragmas, se considera que todos los sistemas estructurales, 

lo contienen, ya sea rígido o flexible, además cuando se tiene que son 

resistentes y de rigidez suficiente, para funcionar como plano rígido. 



 

 

70 
 

Diafragma horizontal, se asigna así: Elige área nivel (Ultimo) y 

secuencia►Assign►Joint/point►Diaghagms. 

 

 

Se elige ●diafragma rígido, aplicados a proyectos similares y el proceso se 

sigue con resto de niveles, asignando los diferentes diafragmas hasta loby. 

Diafragma 

rígido o flexible 

Forma en que se visualiza 

diafragma, al ser simétrico 

se ubica en centro masa, 

irregular  varía. 



 

 

71 
 

Para poder terminar con la asignación del análisis dinámico se procede con 

secuencia►Analyze→Dynamic analysis●Dynamic analysis►Set Dynamic 

Parameters→ introducir datos correspondientes. 

Se maneja que por cada nivel existen tres modos de vibración y por 

consiguientes al tener 14 niveles, se proceda a number of modes= 14*3= 42 

 

Los otros parámetros, como frecuencia cambio yde corte, es adecuado utilizar 

los datos por defecto. Si el cambio no es cero, se pueden realizar análisis de 

espectro de respuesta y tiempo de historia. 

 

Se elige Eigen 

vectores 
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3.5- Consideraciones de efecto Pdelta. 

Para incluir los efectos P-delta en el análisis estático y dinámico, el cual está 

basado en el movimiento lateral de una masa de piso hacia una posición 

deformada, generando momentos de volteo de segundo orden, por lo tanto los 

momentos adicionales de volteo sobre el edificio serán iguales a la suma de los 

pesos de cada nivel y multiplicados por los desplazamientos.  

Si se considera que la estructura del edificio, tiene bien condicionadas las 

relaciones de Rigidez/Wnivel x nivel, entonces los efectos P-delta no son 

significativos, si son menores del 5%, caso contrario pueden aumentar hasta en 

un 25%, en consecuencia  se dice que la estructura está mal diseñada.  

Por consiguiente esto no da una pauta y lo mejor es realizar el análisis con 

efectos P-delta, y si los desplazamientos difieren por más del 5% se considera a 

la estructura muy flexible y se debe corregir la rigidez. Para asignarlo se tiene, 

Analize►Set analisys options►Include P-delta►elige método (Iterativo-

basado en combinación de cargas) 

 

Incluir efecto P-delta y 

usar una combinación. 

Combinación de carga 
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3.6- Verificación y aceptación final de la estructura. 

Entonces se tiene la información del modelo con asignación de efecto P-delta  

ya que se debe corroborar si la estructura es lo suficientemente rígida. 

Al correr el análisis con efectos P-delta, ya sumarian 4 análisis estructurales, 

hasta esta instancia, y después de las verificaciones estaríamos  siguiendo el 

proceso para que la estructura del edificio sea la adecuada y proceder a su 

aceptación final para el siguiente paso.  

La primera verificación será que el Corte Basal estático debe ser igual al 

Dinámico y esto se verifica de la siguiente forma: 

Display►Show tables► eligen las tablas que uno requiere► eligen load-

cases/combos y ok 

 

Elige parámetros de salidas, corte 

basal, participación modal etc.   

Eligen cargas, y sus respectivos 

combos según aci 318-05 
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Luego se procede a ir verificando cada Item, solicitado, de tal manera que estén 

dentro de los parámetros establecidos por códigos y teniendo lo siguiente: 

Participación modal se verifica que llega como mínimo al 95% de participación 

en nuestro caso llega al 96.11% aceptable. 

 

Se sigue con el corte basal, la gráfica nos da la siguiente información 

 

Vx=Vy=2831.48 kips,  y SPCTX IBC03= 139.49 Kips  Y SPCTY IBC03= 131.93 

Kips, para lo cual habrá que calcular el factor de ampliación de la siguiente 

forma:  
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fx=2831.48/139.48=  20.2988    y   fy=2831.48/131.93=  21.4619 y rectificando 

en la casilla aplicable a sismo dinámico así:Define►Response spectrum 

cases►SpecX/Modify/show► aplica factor en Scale Factor y ok 

 

Luego se procede nuevamente a correr el modelo, (5ta vez) y se verifica que 

cortes basales, estáticos y dinámicos estén iguales, para nuestro caso se 

verifico que están iguales a esta instancia por lo tanto ok. 

Factor multiplica lo 

existente aquí, tanto 

para spctX y spctY 
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Cortes iguales, 

estático= Dinámico 
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Luego se procede  chequear las derivas, las cuales deben  cumplir lo siguiente: 

De tabla 12.2-1 de ASCE-7  proporciona la siguiente información 

R= 8.00 

 Ωo= 3.00 

 Cd= 5.50 

 I= factor de importancia según sección 11.5.1 de ASCE-7 

Factor de importancia                                         1.25 

  Categoría de ocupación                            III 

Para verificar la deriva de piso se tiene 

∆t=Cd (δe2-δe1)/I   ≤  ∆a 

δe2/1= dato computado de nivel superior o Inferior  

 

Sismo en X 
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Los datos computados son: 

 Δtechox= 1.032414 ft  y δe14x= 1.025766 ft 

Aplicando fórmula tenemos: ∆t=Cd ( δe2 -  δe1)/I ≤ ∆a     

∆tx=0.006404*5.5/1.25=0.02925 ft    →    ∆t=0.35 in →    ∆t=0.891 cm 

∆ty=0.006648*5.5/1.25=0.02818 ft    →    ∆t=0.34 in →    ∆t=0.86 cm 

De table 12.12.1 de ASCE-7   y categoría de ocupación III 

Tenemos ∆a  = 0.015* hnivel       y   h nivel= 173.2285-161.0894=12.1391 ft 

∆a = 0.015*12.1391= 0.182086 ft   →   ∆a=2.185 in →    ∆a=5.5499 cm 

Entonces ∆ty ≤ ∆ay   se considera bien y está muy por debajo de lo permitido 

chequea y ok. 

Verificando que el efecto Pdelta no es crítico y se acepta la estructura final. 
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CAPÍTULO 4 

Diseño Estructural  con  Etabs9.5 

4.1- Prediseño sísmico según código asignado 

Para llegar a esta instancia,  se rectificó el corte basal sísmico y Dinámico, las 

derivas que estén dentro de los parámetros establecidos según códigos, por lo 

tanto se procederá a realizar un pre-diseño estructural que incluye sismo, este 

proceso nos indicará si los elementos están bien, deben cambiarse, agregar 

otros elementos, etc. De tal forma que la estructura sea óptima, y de ser así, se 

preparan varios elementos con sección constante y área de acero diferente, con 

la finalidad de  poder cambiarlo en diseño final y se comienza con la siguiente 

secuencia: 

Options►Preferences►Concrete frame Design►eligen códigos a usar y 

ok 

 

Para iniciar a diseñar se sigue la secuencia: 

Códigos ACI318-05  e IBC06, Se 

eligen aquí. Resto son parámetros 

propios de códigos. 
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Design► Concrete frame Design►Star Design/Check, of structure,  ok y 

comienza a diseñar elementos (vigas, columnas) 

 

Terminado el diseño estructural se procede a solicitar información sobre 

elementos, tal como: %acero longitudinal, rel 6/5 viga débil/columna fuerte, etc. 

Y siguiendo la secuencia:  Design► Concrete frame Design►Display Design 

info,► requiriendo (6/5) Beam/Column capacity Ratios,  luego se elige una 

columna (o viga) y aparecen las dos ventanas donde la información nos indica 

que para este nivel la columna está sobrada y por lo cual se deberá disminuir 

sección  o  % de acero, esta fase es muy importante en el Pre-diseño porque 

nos da parámetros de cómo se deben ir cambiando los elementos o agregando 

otros elementos ya con % de refuerzo, que será el paso a seguir. También se 

pueden visualizar que las columnas desde sótano 4 hasta el nivel 6, las 

columnas no chequean, indicando que aquí se deberá aumentar sección o área 

de acero hasta un máximo de 4%. 

Visualización de un elemento columna sobrada y además puede verse las que 

no chequean. 
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Y así sucesivamente se van chequeando los marcos hasta tener una idea de 

donde se deben cambiar o armar de mejor forma los elementos, aumentando 

sección, área de acero, además puede ser todo lo contrario que sería disminuir. 

 

Al elegir una viga  se puede visualizar que aparecen estos datos en rojo, 

indicando que la seccion es inadecuada, para lo cual es necesario armar la 

misma con refuerzos que cubran el % requerido, e ir rectificando los demas 

parametros para que la misma cumpla con los requerimientos del ACI318-05 

que es el código seleccionado. 

Columnas no 

chequean 
Columna sobrada 

esta relación ideal 

0.85 a 0.90 
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Al solicitar el % de refuerzo en vigas o columnas, nos indica cuánto de refuerzo 

deberá colocarse al elemento, y para solicitar se procede así: Design► 

Concrete frame Design►Display Design info, ► % refuerzo longitudinal 

 

Al proporcionar la información se termina de corroborar hasta dónde se pueden 

armar columnas y vigas,  en % acero o cambiar sección, además también 

proporciona el combo de diseño crítico.   

Esta fase es de mucho criterio, ya que se deben tener claros todos los 

conceptos estructurales como, Asmín, Asmax,  que las cantidades de refuerzo 

superior e inferior requeridas cumplan con las condiciones del ACI318-05 para 

vigas y columnas. 

Indica el refuerzo en plg2 y 

con esto se pueden ir 

armando elementos. 
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Teniendo el  modelo con la última aceptación donde cumple con efecto Pdelta, 

sismo estático  y dinámico, se procede a quitar el candado y se comienzan 

armar los diferentes tipos de columnas,  y vigas con sus armados finales, los 

cuales se realizaran según información indicada anteriormente, y se procede  a 

realizar el Análisis tridimensional  y  diseño estructural del proyecto, donde al 

requerir información los elementos deben chequear o ir cambiando a un nuevo 

elemento ya predispuesto, de tal forma que al cambiarlo chequee, esta fase de 

Diseño estructural es la más interesante y la más compleja, ya que se deben ir 

homogenizando elementos y aplicando todos los conceptos estructurales de los 

códigos utilizados, además  de aplicar criterios técnicos de construcción, es 

decir, aplicar la experiencia  de gabinete, de construcción y/o supervisión de 

obras, y nuevamente un recordatorio que realizar un Análisis y Diseño 

estructural, en Etabs, no es sólo ingresar datos al mismo, lógicamente la 

experiencia se gana con el tiempo,  porque de nada sirve colocar los refuerzos 

necesarios y cumpla los  requerimientos de códigos, si al final  en la ejecución 

tiende a ser demasiado complicado y oneroso, obteniendo un análisis y diseño 

aceptable, pero constructivamente inaceptable, por lo tanto la experiencia de 

campo estructural es un factor muy importante. 

4.2- Análisis Tridimensional de estructura definida. 

Se inicia por crear nuevos elementos como columnas y vigas, las cuales se irán 

definiendo por sección y su respectivo % de refuerzo, comenzando con la 

siguiente Nomenclatura: 

C1= columna de 1.00x1.00 mts. y refuerzo del 1% 

V1= vigas de mayor dimensión y refuerzo indicado en tabla. 

La siguiente tabla desarrollada en Excel nos indicará cuántas columnas se 

definirán. 
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Tabla VII. Cálculo de Armados de diferentes columnas. 

En la Tabla 5.- se definieron  tipos de columnas y % de refuerzo en diferentes 

elementos, con  una variación de 10 cms. Por lado, es decir columnas desde 
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1.10 mts. hasta 0.70 mts., usando varillas No.8, que es la tradicional en el 

medio, y sus respectivos porcentajes de refuerzo desde el mínimo (1%) hasta el 

máximo (4%). 

Como se puede visualizar podrían salir 12x5 = 60 unidades de columnas 

diferentes, pero al haber chequeado el modelo anterior donde nos proporciona 

los porcentajes máximos o refuerzo longitudinal requeridos, nos da un 

parámetro de cuales debemos de armar y homogenizar. 

Para columnas de 1.10 mts. – 1.00 mts.  y 0.90 mts., se utilizaran del 1%, 

1.25%,1.50%,1.75% y 2%, dando desde C1 hasta C15 (15 unidades), y para 

columnas de 0.80mts. y a 0.70 mts., se utilizara del 1% hasta el 2.0%, dando 

desde CS1 hasta CS10 (10 unidades). 

De igual forma se procede con vigas, con esta fase de armado de vigas lo ideal 

es realizarlo por ejes y niveles, de tal forma de homogenizar al máximo, es decir 

que varios ejes similares tengan la misma viga y armado. 

En un edificio las cantidades de elementos vigas pueden ser demasiadas que 

sería tedioso y demasiado complicado ir realizando una por una y que al final se 

tengan armados de una infinidad de vigas. 

La construcción sería muy complicada y la supervisión mucho más, por lo tanto 

se provee de una cantidad de vigas acordes a la estructura, es decir  de 6 a 10 

tipos de columnas por nivel, y de ser posible que se repitan en varios niveles 

típicos, que es lo normal en una edificación como esta. 

El mismo concepto se utiliza para columnas, solo que para este elemento ideal 

sería solo definir de 2 a un máximo 4 tipos de columnas por nivel, para 

realizarlo se sigue la secuencia Design► Concrete frame Design►Display 

Design info, ► longitudinal refuerzo, ok,  

Y aparece el refuerzo longitudinal del marco requerido 
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Mostrando  áreas de acero de vigas y columnas. 

Área acero en 

plg2,  
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Siguiendo la secuencia Display► Show member forces/s►frame/ppierts,► 

Elige combo (UDCON40)/ para M3-3 y que muestre valores. Luego se elige 

un elemento y se le requiere información, para este caso su envolvente, el cual 

nos indica el combo de diseño,  a flexión, corte y torsión,  y su respectivo 

refuerzo 

 

En la ventana de la izquierda entonces se solicita los momentos debidos a este 

combo. Con esta información se procede a ir armando y homogenizando vigas 

en marcos y niveles, como se puede observar, el proceso es complejo y de 

mucha paciencia, ya que conjuntamente se van armando hojas Excel,  para ir 

dejando información valiosa que más tarde nos ayudara a definir los elementos 

cuando se pase al diseño final . 

Como anteriormente se mencionó este proceso debe ser ejecutado por un 

ingeniero estructural y no dejarlo a ingenieros que no tienen la suficiente 

Homogenizar eje de viga, con 

momento máximo y su 

respectivo combo por medio 

de envolvente. 

Refuerzo longitudinal a corregir, 

según armado final y cumpliendo 

códigos 
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experiencia, porque tienden a definir  elementos sobre diseñados o en el peor 

de los casos sub-dimensionados, de aquí la importancia del buen uso de estos 

programas, que como se está demostrando no es un proceso de solo ingresar 

datos. 

Algo importante es ver que los momentos estén a rostro de columna, 

corroborando se toca un elemento viga en ventana izquierda y cuando aparece 

el momento se chequea que está a 0.50mts.= 1.64pie, lo cual es correcto y ok. 

 

L ejes= 8.50 mts., columna 

de 1.00,  entonces debe 

comenzar a 0.50mts=1.64 

pies como se verifica, ok 
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Tabla VIII. Cálculos, dimensiones Vigas con Asmx. Amín, Mmáx y Mmín. 
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Tabla IX. Definición de vigas a usar 
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Con información y posibles secciones, se arman vigas y se hace por nivel, 

además se deben ir chequeando por ejes,  ideal que en un nivel se requieran la 

menor cantidad de tipos de vigas, es decir V1, V2, V3 y V4, por decir algo, y 

que no existan veinte tipos de vigas en un nivel, por un cambio de un refuerzo, y 

es aquí donde el  ingeniero estructural pone todo su esfuerzo y conocimiento 

para ir armando el eje completo de la mejor forma,  según tabla 7. de Excel se 

estimó que se deben armar 15 tipos de vigas en todo el edificio, lógicamente 

para nuestro caso, se trabajó un solo marco, puede ser que puedan existir más, 

de hecho  para el tipo de edifico definitivamente serán más, aparte de ir 

homogenizando, se deben realizar los armados óptimos, que cumplan con 

todos los parámetros de los códigos, además de que se puedan ejecutar de la 

forma más sencilla en obra, así el proceso descrito anteriormente se debe 

realizar a todo el edificio,  y se puede decir que este proceso no solo lo debe 

integrar un ingeniero estructural con experiencia en cálculo y  supervisión, debe 

ser realizado por un equipo estructural de una forma óptima. 

Ahora se procede según sección 3.3 Modelación de Geometría. Iniciando por 

desconectar candado así: Ícono Candado► Aceptar,  y se inicia ingreso. 
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Con secuencia Define► Add rectangular►Reinforced, se definen columnas y 

vigas y se obtiene lo siguiente: 

 

Así se conforman todas las columnas nuevas a usar, hasta completar las 

requeridas según tabla 5,  creada en Excel, para nuestro caso se concluyó que 

deben ser 27 tipos de columnas. 

Para C2, se deben 

colocar 26No.8,  ok 

Aquí, se  designa columna, 

estribos, recubrimiento, 

cantidad y diámetro ref. 

Dimensiones de columnas 
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De igual forma se conforman la vigas  con secuencia: Define► Define frame 

properties►Add rectangular►Reinforcement- beam 

 

Al estar completados todos los nuevos elementos columnas y vigas, se procede 

asignar el elemento estimado inicial en estructura. 

Asigna beam, recubrimiento, ref. 

Superior e inferior, según cálculo 

inicial, y confirmado en tabla 6  y 7 

de Excel. 
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Finalmente se analizar estructura tridimensional, con secuencia  Asign► Run 

Análisis o ícono 

Aquí está corriendo el nuevo modelo con todos los elementos ya prediseñados 

Se procede a chequeos de derivas, el corte basal sísmico. 

Proceso para inicio de 

análisis estructural 

Proceso de análisis 

estructural en ejecución. 
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Se muestran derivas, períodos, y los mismos están dentro de los parámetros 

requeridos: 

 

Derivas 

cumplen y ok 

Período ok, traslación y 

rotación también. 
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Se verifica qué corte Estático y Dinámico, 

cumplen.

 

Ya comprobado todos los requerimientos de códigos, el modelo está disponible 

para proceder a realizar el Diseño de estructura Tridimensional. 

4.3- Diseño de Estructura Tridimensional. 

Para esta fase, también habrá que corroborar que el diseño se realizara con los 

códigos definidos con anterioridad siguiendo la secuencia 

Option►Preferences ►Concrete frame Design→Elige códigos y ok 

 

Sismo estático = Dinámico ok 

ACI318-05/IBC03, Y resto de 

parámetros 
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Luego se procede a correr el modelo para que diseñe los elementos de forma 

general y hasta que está finalizado se procede a ir rectificando cada elemento 

como vigas o columnas así sea el caso, con la secuencia es Design► 

Concrete frame Design►Start Design/check of structure 

 

Se visualiza el inicio de diseño estructural de todos los elementos, y dependerá 

de la máquina que se esté usando, así se tardara en ejecutar el diseño 

estructural. Terminado el diseño se procede analizar el diseño de columnas y  

vigas, que será la siguiente fase donde el ingeniero estructural termina de afinar 

cada elemento por eje y nivel respectivo, a modo de optimizar la estructura. 

Inicio de proceso de 

diseño estructural según 

código elegido 
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4.3.1- Columnas 

Se comienza con solicitar la iteración de ratios o el requerimiento que uno 

desee con secuencia Design► Concrete frame Design►Display Design 

info.→ y finalmente el requerimiento deseado 

 

 

Por lo tanto se procederá se  a ir cambiando los elementos según pre diseño 

generado en tabla 5,  de Excel, y  para efectos de lo trabajoso que es esta fase, 

Aquí el requerimiento, desde refuerzo 

longitudinal, hasta rel. Columna  fuerte 

–viga débil 

Se comienza a ver que ciertas vigas no 

chequean y que ciertas columnas 

están dentro del  límite. 
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se  realizara un  eje/nivel completo, se trabajara el nivel 10, eje 3 y D, y 

secuencia: Toca elemento► Envelope  → y aparece así: 

 

Se visualiza que la columna fuerte se considera  sobrediseñada, por lo tanto es 

necesario variar las áreas y/o cantidades de refuerzos,  se requiere ir 

conjugando, si se comienzan con 24 refuerzos, el siguiente nivel puede ser 18 

refuerzos, aplicando criterio estructural. 

Rel= 5.34, ideal  se 

requiere que sea 1.20 

esta sobre diseñada 

Es 
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Se realizan las demás sucesivamente, de tal forma que todas sean del mismo 

tipo en un mismo nivel, lógicamente en algunos puntos quedara  ajustada o 

sobredimensionada, pero la variación debería estar dentro de 0.80-0.95,  

asignando columna CS11, con medidas de 0.70x0.70 y 20No.8, (2.08%)  su 

relación es 0.796 @ 0.917 considerado bien y ok. Lo anterior para nivel 10.  Se 

continuo con nivel 11 y se asignó la misma columna y la relación es 0.718 @ 

0.817 considerado bien, luego se probó con una columna CS10, con medidas 

de 0.70x0.70 y 16No.8 (1.67%) y su rango de relación quedo en 0.772 @ 0.873, 

ambas cumplen. 

Aquí se marca y 

cambia el tipo de 

columna y se va 

chequeando 

La rel. Queda en 0.917 

ok, es el rango deseado 
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El ir haciendo estas variaciones nos refleja que se comienza a fundamentar 

mejor el diseño, y será el ingeniero estructural quien decida, ya que también se 

comienzan aplicar conceptos de costos, entre una y otra columna la diferencia 

es 4 ref. No.8, que definitivamente es un costo considerable, pero 

definitivamente lo principal es la seguridad estructural. 

Con lo anterior se confirma que para obtener una estructura que cumpla 

requisitos de códigos, económica y su ejecución sea factible, convierte el 

Diseño Estructural en una fase de iteraciones múltiples y complejas. 

Aquí se realizó el nivel 10 y 11, como un ejemplo, pero se debe ir realizando de 

abajo hacia arriba, para  idealizar la estructura. 

El anterior proceso se debe realizar por eje- niveles, de abajo hacia arriba, 

muchas veces cumple en un eje pero en los siguientes tiende a ser más crítico 

o sobrediseñado. 

Hasta aquí solamente se tiene las columnas  de unos niveles, y solamente un 

marco, el ir conjugando todos los niveles y marcos de tal forma de homogenizar 

las columnas conlleva un tiempo considerable. 

El costo de realizar Cálculos Estructurales es alto,  estos programas por ser 

muy amigables para su uso, se tiene la idea que solo  se deben ingresar datos y 

corres el análisis estructural, y diseñar, los cual es falso, con este estudio se 

pretende, es  crear conciencia de que es un proceso muy complejo y no dejarse 

deslumbrar por la información que proporcionan estos programas, porque  

como todo programa si se ingresan datos erróneos se obtendrán Momentos, 

cortes, derivas  y diseños incorrectas, teniendo consecuencias graves para la 

ingeniería estructural en Guatemala. Es necesario que el colegio de ingenieros 

y asociación de ingenieros estructurales coordinen cursos de actualización 

sobre estos programas.  
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4.3.2-  Vigas 

Se comienza con solicitar la relación column/beam capacidad ratios  y se 

obtiene con secuencia: Design► Concrete frame Design►Display Design 

info.→ column/beam capacity ratios 
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Se visualiza que la columna diseñada  ya chequeada, con las vigas diseñadas 

inicialmente sin ningún chequeo,  aquí indicando que no chequea. Los 

requisitos deseados para que chequee  no se están cumpliendo al 100%, por lo 

que se procede  a cambiar por otras vigas según tabla 6 y 7, hasta que chequee 

y siguiendo secuencia: Toca elemento► Envelope  → y aparece así: 

 

 

La viga no chequea, y refiere que el esfuerzo de 

corte y torsión exceden lo permitido, entonces 

cambiar sección y/o armado según prediseño. 
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Luego se procede así: Toca elemento► Overwrite  → y aparece así: 

 

Entonces después de asignar la V4 a nivel 10 y 11 aparece lo siguiente: 

 

Se da ok, y se visualiza que viga cumple los requerimientos, para su 

rectificación, nuevamente se solicita la envolvente y se comprueba datos. 

1.-Ahora se marca 

overwraties,  aparece ventana 

izquierda y se cambia a viga 

requerida 

Según prediseño 

corresponde en este nivel 

la V4, ver tabla 7 

2.- Se verificando que chequea, a 

flexión, corte, torsión  y ok 
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Luego se procede con el resto de vigas, en este eje y nivel, se visualiza que al 

hacer el cambio, la nueva viga cumple todos los requisitos del ACI-05 

 

 

El realizar el  trabajo en un solo nivel y  eje  es complejo, pero esto se debe 

comenzar de abajo hacia arriba, e ir viendo que todas las vigas -columnas 

cumplan los requisitos del ACI-05 

El ir cambiando vigas,  según 

requerimiento, hace que las 

nuevas vigas cumplan los 

chequeos respectivos. 
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Además se pueden variar las dimensiones a criterio, siempre y cuando se 

cumpla con los requerimientos de códigos. Si uno no arma la viga, el programa 

asume un refuerzo y estima en función del No. Varilla usado en columna, y 

ajusta a varillas completas, muchas veces se pasa porque el programa  no tiene 

la capacidad de armar la viga con diferentes tipos de varillas, entonces el 

ingeniero estructural debe diseñar de tal forma que  el área requerida sea igual 

o mayor al requerido. 

Ejemplo. De datos de diseño en Etabs el requerimiento de acero, As - =4.04 

plg2 (acero superior), entonces si uno no ajusta o rectifica esta área de diseño 

el programa resuelve de la siguiente forma: 

Primero decide la varilla a usar y toma la más cercana a diseño, en este caso la 

No.8 que fue la que se le proporciono a la columna, entonces lo deja así: 

6No8=4.74 plg2, y se considera que cumple con todos los requerimientos, pero 

aquí es donde el ingeniero estructural debe decidir y armar de tal forma que se 

puedan conjugar dos tipos de varillas y llegar al requerido (el As - =4.04 plg2)  y 

entonces se procede de la siguiente forma: 

 3No.8 (2.37 plg2)+4No.6 (1.76 plg2)=  4.13 plg2>4.04 plg2 ok  opcion1 

 4No.8 (3.16 plg2)+2No.6 (0.88 plg2)=  4.04 plg2  ≥   4.04 plg2 ok opcion2 

El realizar estas dos opciones posibles hace del diseño estructural sea un 

proceso complejo, porque también se debe ir trabajando el aspecto de 

ejecución en obra, de tal forma que se cumplan todos los requerimientos del 

ACI318-05, y finalmente se cubre el aspecto económico, porque se reduce 

cantidad de acero, y así el ingeniero estructural con criterio y experiencia puede 

decidir lo más conveniente a la estructura y economía, confirmando que esta 

parte no la puede procesar el programa y solamente el ingeniero estructural y 

civil pueden desarrollar esta fase. 
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CAPÍTULO 5 

Interpretación de datos en Etabs9.5  y comprobación 

por programas en hojas Excel 

5.1- Interpretación de información proporcionada por programas. 

En este paso de análisis de información, prácticamente el edificio ya está 

terminado y los elementos que se han diseñado se deberán comenzar a dibujar, 

es decir la información técnica que indica que un elemento, por citar un ejemplo, 

que la columna C1 se diseñó así, deberá tener la siguiente información: 

geometría de sección 1.00x1.00 mts. y su refuerzo vertical es de 24 No.8, con 

estribo y eslabón No.3, 1@5, 12 @ 8 y resto @ 25, (confinada)  por citar un 

ejemplo. 

Se debe plasmar en planos detallados, para que realmente el modelo sea 

representativo del análisis y diseño estructural realizado, aquí también entra la 

ingeniería de Detalle, (ver 1.3.- Ingeniería estructural de Detalle) y la cual se 

mostrara en el capítulo 7. 

Ahora con la información general detallada provenientes de Etbas, cualquiera 

que se haya usado, en este capítulo se verificara que los mismos cumplen los 

requisitos cuando se diseñan con programas desarrollados en Excel, lo cual nos 

ayuda a fortalecer el criterio estructural y a su vez tener una doble verificación.   

Para el requerimiento de información de Momentos, cortante, torsión, cargas, ya 

sea para  vigas o  columnas del modelo analizado. 

Si se solicitan todos los datos se crea un archivo muy grande y por lo general se 

comienza también a homogenizar y se pretende desarrollar un eje crítico 

(central) y otro menos critico (extremo), y al tener los datos se procede a 

confirmar los elementos homogenizando por nivel y eje. 
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Solicitando información de  elementos, se procede así: Eligen elementos 

columnas, vigas, losa (mouse en planta o elevación) ►Display ►Show 

Tables,  luego se elige la información de salida a partir de ANALISIS 

RESULTS, marcando una x así: 

 

En ventana se marcan los requerimientos según se indica y se da ok. 

Elección de elementos 

con mouse 
Marcar requerimientos 
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Aquí se terminan de elegir los casos de cargas, combos y ok. 

Seleccionar  de casos 

de cargas 

Marcar la elección 

requerida, reacciones, 

frame output etc. 

Selección de 

combos 
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Luego aparece la siguiente tabla y sus respectivos requerimientos solicitados 

Aquí se va eligiendo la información de salida de los elementos seleccionados, 

para este caso vigas del nivel 10 y 11, eje 3/B-E y D/2-5. 

Datos de Momentos 

cortantes y carga Elige requerimiento, como: 

BeamDesignForces, etc. 
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Para trasladar toda esta información a Excel se procede así: 

Edit ►Copy entire table o Ctrl+C,  Luego en un archivo de Excel se copia 

información quedando lo siguiente: 

 

Tabla X. Información de vigas, de Etabs 9.5 a Excel 

 

Inicio a rostro de 

columna 

Los momentos, cortantes para 

carga Muerta, Viva, sismo, etc. 

Están calculados a cada 0.50 

mts. Inicia en 1.64 pies hasta 

26.247 

Con esta información se procede a 

obtener el Mmáx (-) y Máx. (+) y se 

realizan las combinaciones según 

código 
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Tabla XI. Información general de Etabs9.5 a Excel (cantidad total de hojas). 

Para efectos de información esta hoja es suficiente, como se puede visualizar 

para este nivel y tres vigas que conforman el eje 2/B-E son aproximadamente 

111 paginas 
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Tabla XII. Información de Columnas, de Etabs 9.5 a Excel 

Para efectos de información esta hoja es suficiente, como se puede visualizar 

para este nivel y cuatro columnas que conforman el eje 3/B-E son 

aproximadamente 41 páginas. 

Información de cada columna 

en tres puntos, inferior, medio 

y superior para todos los casos 

de cargas 
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De esta forma se trabaja también la información de losas y cimentaciones.  

Ahora se procederá a la comprobación de información desarrollada en Etabs  

con programas en Excel, comenzando con el diseño de vigas: 

5.2- Vigas 

Se solicita el refuerzo longitudinal, con secuencia:Design ►Concrete frame 

Design ►Display design info►En ventana ●Design output→Longitudinal 

reinforcing,   

 

Se amplia para verificar las cantidades en plg2. Del  eje 3/B-E se tiene: 

Aquí el refuerzo en 

plg2, en tres 

secciones de viga 
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Se diseñara  y verificara el eje 3/B-E, con las siguientes tablas XII y XIII: 

 

Nivel 12 se diseñara y 

verificara 

Mnivel12diseño-eje 3/ED=1070.7k-

p 
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1070.70 297.46 920.62 1197.0 378.85 1194.28 924.71 357.17 1060.68

730.01 430.07 787.62 818.54 570.08 817.88 780.72 425.95 731.62

As- 7.74 2.65 6.56 8.76 2.65 8.74 6.59 2.65 7.66

As+ 5.11 2.94 5.55 5.78 3.94 5.77 5.49 2.9 5.13

COMPROBACION  DE DISEÑO DE VIGAS  NIV. 12  DEL EJE 3/B-E y  F`c=4,000 psi - fy=60,000 psi

Maximos y Minimos para diferentes tipos de vigas  y  F`c=4,000 psi - fy=60,000 psi

Nive

l 12

M- niv. 12

M+ niv. 12

EJE 3 / B-E  de Informacion extraida de  Etabs9.5

NIVEL MOMENTOS (K-PIE)   Y  AREAS  (Plg2)  DE ACERO POR DE ETABS9.5 

E-D D-C C-B

 

Tabla XIII. Comparación de cálculos de momentos y As diseño. 

De Tabla XII se procede a chequear  Momentos y As, esta información se 

obtiene  del programa de Etabs, y con Tabla XIII. Se procede a chequear el 

As Mnivel12= 7.74 plg2 

Mnivel12diseño-eje 

3/ED=1070.7k-p 
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momento y as, con las mismas caracterizas que usa el programa obteniéndose 

lo siguiente: 

2No10 2.54

3No10 corridos 3.81 Ascorrido>Asmin ok 

4No10 B/riel 5.08 Complemento

As requerido 7.74 plg2

diferencial 3.93 plg2

USAR No: 10

3

No10 3.81 plg2

7.62 plg2

M Etabs 1070.70 99.33%

M Verificado excel 1063.54 0.67% error, ok

OK Satisfactorio3No10 C+3No10- baston

As total propuesta de diseño

ɸAs colocado  No.10

PROPUESTA DE DISEÑO ESTRUCTURAL EN VIGA (ARMADO), viga 3/E-D 

Niv.12

 

CALCULO DE MOMENTO y As Base 0.60 23.616

Dimension Viga concreto Altura 0.90 35.424

a=D. Var Uti 1.00 0.5

Estribo No.3 0.38 plg

Recubrimiento 4.57 cms

Mres. U= Þ*As*fy((d-(As*fy/1.7*fc*b))
Donde: Þ=Factor S. 0.9 As minimo=2.608

7.74 As maximo=11.150

7.62 3#10c + 3# 10

fy=Esf. Acero 60,000.0

Fc=Esf. Conc. 4,000.0

d=Peralte V. 33.1

Masreq.= 1063.54 Kip-pie 464400.00

Mdiseño final= 1048.61 Kip-pie 1,7xfcxb

OK SATISFACTORIO Asxfy / 1,7xfcxb

As=Area Acero requerido

As=Area Acero propuesto

 

TABLA XIV. Cálculo de momento y As diseño. 

Con lo anterior se verifica que los datos de diseño son correctos y la variación 

es mínima (0.67%) considera  nula, es decir no afecta en nada. 

Mde comprobación= 

1070.70kl-p  y As=7.74 
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Se visualiza que el programa solo proporciona una cantidad de refuerzo  (7.74 

plg2) y en la fase de diseño estructural es donde el ingeniero (ser humano) 

puede decidir y tomar decisiones correctas que contemplen: 

1.- Lógica de armado estructural 

2.-Cubrir Refuerzo mínimo requerido con varillas completas y lógicas de armar. 

3.-Conformar  paquetes C/ varillas diferentes diámetros, fácil y lógicas de armar. 

4.-Al armar un eje completo, tener  varillas corridas que cumplan con el Amín. 

5.-Lo anterior implica ir conjugando varillas del mismo  o diferente diámetro, 

decidiendo por la   opción más lógica en armado estructural y económico. (Una 

varilla puede hacer la diferencia). Si se considera que en un edificio son 

considerables las cantidades de vigas, el ahorro lo es también. 

Del armado anterior se decidió colocar 3No10 como refuerzo corrido, esto 

cumple muy bien con el Amín, y 3No10 (3.81 plg2) >Amín= 2.608 plg2. ok 

El diferencial se cubre con Bastones o Rieles según requerimiento estructural: 

Para el tramo  3/ED  el diferencial  en extremo izquierdo con 3No10 (3.81 plg2), 

con un total de As diseño= 7.62plg2 ≥ 98% As requerido=7.74 plg2. ok 

Cabe mencionar que en este proceso  los ejes colindantes con mayor momento  

rigen para armar,  concluyendo: 

Eje 3/D rige el desarrollado anteriormente y el voladizo queda sobrado. 

Eje 3/D  rige el área de acero del lado derecho es decir la viga 3/D-C. 

Eje 3/C rige el área de acero del lado  izquierdo es decir la viga 3/D-C 

Eje 3/B rige el área de acero del lado  izquierdo, similar como se realizó el eje 

3/E. concluyendo que se requiere experiencia y lógica. 
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Los datos verificados están basados por el Análisis y diseño estructural 

desarrollado por el programa Etabs9.5,  y coincidiendo en 99.33%, como se 

verifico en Tabla III. 

Se procederá a diseñar con el momento de condición crítica y adaptar la 

sección  que cumpla todos los requisitos de ACI318-05 como se muestra a 

continuación en tabla XIV. 

 

Tabla XV. Diseño As, Nivel12 eje3/EB (armado de vigas) 
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De la información anterior se puede apreciar lo complejo que se vuelve este 

proceso de diseño estructural, pero el tener el concepto estructural ayuda a 

desarrollar el diseño  más eficiente y lógico en vigas completas, aquí se fueron 

variando cantidades o número de varillas (No.10, No8, etc.) y en los ejes donde 

se tiene la unión de dos vigas se debe definir cuales rigen, (ver Tabla XIV), ya 

que el programa no puede desarrollar este concepto estructural, y este manual 

hace referencia constante a este proceso donde el profesional debe completar 

satisfactoriamente esta fase, a continuación el armado final del eje 3/B-C. 

 

GRÁFICA   10. Armado de vigas en eje completo 
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Puede visualizarse que el armado coincide con lo diseñado finalmente descrito 

en tabla XIV. Este proceso que se viene realizando se debe trabajar en todos 

los ejes y niveles respectivos, de tal forma de ir homogenizando al máximo. 

Como se observa en la GRÁFICA 10, se tomaron decisiones lógicas, eficientes 

y sobre todo económicas, sin perjudicar lo estructural, es decir se cumplen los 

requisitos de diseño estructural del ACI318-05. 

El desarrollo de la Tabla XIV, se inicia con obtener los momentos críticos 

(envolvente) que son los máximos esperados, y desarrollándose en base de un 

elemento definido (viga) en dimensiones, especificaciones de refuerzos y 

concreto, que nos proporcionaran el Asmin→Mmin, y Asmax→Mmax, para 

luego proceder a calcular el As-requerido, el cual debe ser Mayor que Amín 

pero Menor que Asmax. 

Seguidamente se procede a configurar el refuerzo corrido (Asc) el  cual debe 

cumplir  siempre los requisitos del código y a la vez que sea mayor que el Amín, 

procurando también que este refuerzo cubra los momentos en los puntos 

medios superior e inferior, aunque este último no necesariamente debe 

superarlo, ya que se puede cubrir con Asdif= acero diferencia,  y que se nombra 

Riel. 

Luego se calculan todas las áreas diferenciales, (Asdif.) que será la resta del 

As-requerido menos Ascorrido, este diferencial de área se puede cubrir con 

varillas de igual diámetro del área Asc, o ir conjugando con otro tipo de varilla, 

que puede ser menor, o igual que varilla corrida, con la intención de estar lo 

más cercano al As-requerido, este proceso es muy complejo, pero es la fase 

donde se puede economizar considerablemente. 

Entonces lo ideal es que el  Ast diseño final sea igual al As-requerida, pero casi 

nunca se da y se termina colocando mayor Área de acero (de 5% @ 15% más) 

al As-requerida, como se aprecia en la TablaXIV y GRÁFICA 10.  
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En otros casos se queda uno por debajo del As-requerida (un 5% menor ok) y 

es la decisión estructural clave, considerando que estos valores obtenidos 

incluyen factores de seguridad, entonces es aquí donde se inicia una buena 

economía estructural, llamada así porque al desarrollar  un Análisis y diseño 

estructural  que llene todos los requisitos de códigos y sea económico, marcara 

la diferencia. 

5.3- Columnas 

Ahora se procederá a la comprobación de información de diseño de una 

columna típica, y con programas  en Excel se harán chequeos, de tal forma que 

los resultados sean iguales o aceptables, es decir que su variación sea mínima, 

y poder llegar a una conclusión satisfactoria. 

Columna eje 3 /D eje X y D/3 eje Y 

 

Col eje 3/D 

Nivel Techo y 14 
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Aquí se muestra la columna a ser comparada en diseño. 

Para solicitar información de la columna eje 3/D nivel 14, se toca elemento, y se 

obtiene: 

 

Aquí se puede solicitar, diagrama 

de interacción,   Flexión, corte,  o 

envolvente, según lo que se 

quiera verificar. 
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Aquí ya está diseñada la columna, entonces se solicita información de 

Envolvente a columna eje 3/D nivel 14 
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Para lo momentos correspondientes a vigas, ya se comprobó anteriormente 

cómo los calcula Etabs y su comprobación, el cual está basado en la sección 

designada y su As final de diseño para este ejemplo se tienen lo siguiente; 

 

Los momentos de Beam 1= V23 corresponde a una viga de 40x75 y área de 

acero  As (top)=3.95 in2 y As (botton)=3.16 in2, se obtiene los momentos de 

410.121k-pie y 503.909 k-pie = 914.03 k-pie, corresponde a beam 1 y 2 = V23 y 

V20, la capacidad mayor. 

Identificación, y 

Medidas de vigas 

Momentos debido al As 

(top) y (botton) de 

diseño final 
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Ahora se procede a comprobar con programa en Excel los resultados de 

columna en eje 3/D Nivel 14, correspondiente a una C13 (90x90) con 22No8 y 

1.38% refuerzo que es Mayor que el mínimo (1%) y Menor que el máximo (4%). 

Diseño de Columna de Concreto

DATOS A INGRESAR

f 'c = 3 ksi

fy = 40 ksi

Largo x = 31,50 in

Ancho y = 23,62 in

Barras  ==>     # 8

No. de Asx = 4 4 # 8  

No. de Asy = 4 4 # 8  

Total Barras  ==>     # 12 # 8

r = 1,27%  

Pu = 300 k

Mux = 100 k-ft ex = 4,0 in

Muy = 100 k-ft ey = 4,0 in

 PASO 4/ CHEQUEO DE LA CAPACIDAD DE LA COLUMNA POR EL MÉTODO BRESLER

300,0 < 1261,2 ok 428,6 < 1860,7 ok 0,452 < 1,0 ok

ANÁLISIS,  Datos  de   ᶓᵤ , ф  y β1

= 0,003 d = 29,00 in 21,12 in

d' = 2,50 in 2,50 in

As = 3,16 in
2

3,16 in
2

= 0,70 b = 23,62 in 31,50 in

Mn = 142,86 k-ft 142,86 k-ft

= 0,90 Mno = 723,52 k-ft 560,64 k-ft

Po = 2071,61 k 2005,18 k

PASO 1.- CALCULO DE CAPACIDAD DE MOMENTO (Pn=0)

2,45 in 2,22 in

-1.949,64 psi -10.846,87 psi

587,25 k-ft 465,58 k-ft

PASO 2.-CALCULO DE CAPACIDAD DE CARGA AXIAL (Mn=0)

2252,23 k = 2252,23 k

PASO 3.-CONDICIÓN BALANCEADA

17,88 in 13,02 in

40.000,00 psi 40.000,00 psi

1076,85 k 1045,90 k

929,66 k-ft 697,57 k-ft

V23

   SENTIDO x    SENTIDO y

V23

V20
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Fuente Daniel T. Lee / Engieneering International. 

Tabla XVI. Cálculo de columnas en formato Excel 
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EJES ANALIZADOS- MOMENTOS DE VIGAS A COLUMNAS

MEDIDAS

EN CMS. Etabs Propio M+ (top) M- (botton) Mayor Menor

40X75 Bean 1 V23 410,121 503,909 914,03 921,66

55X75 Bean 2 V20 417,751 692,744 1102,865 1102,865

40X75 Bean 3 V23 410,121 503,909 914,03 914,03

40X75 Bean 4 V23 410,121 503,909 914,03 914,03

827,87 1.196,65

V20

Col 1.00x1.00  y 20 No8 1,27%

Excel Etabs9.5

∑Mcap. Column mayor (y) 465,58 1493,61 (3,3)

∑Mcap. Column menor (x) 587,25 1466,73 (2,2)

V23 V23

∑Mbfy mayor 913,01 914,03 (3,3)

∑Mbfx menor 1084,33 1102,87 (2,2)

Col. Eje 3/D     Y 0,510 1,634  6/5= 1,2

Col. Eje D/3     X 0,542 1,330  6/5= 1,2 V23

Col. Eje 3/D     Y 2,353 0,734 < 1,2

Col. Eje D/3     X 2,216 0,902 < 1,2

Conclusion Column/Bean Chequear 6/5 Bean/Col ok cumple

Conclusion Column/Bean Chequear 6/5 Bean/Col ok cumple

Informacion obtenida por

 CHEQUEO

RELACION COLUMNA /VIGA   y  (6/5)Viga/Col

Tipo viga Sumatoria Vigas

PASO 5,- CHEQUEO DE COLUMNA FUERTE VIGA DEBIL

Capacidad 

X

Y

 

Tabla XVII. Cálculo Comparativo de diseño de columnas 

Se concluye que el programa  de Etabs tiene bien desarrollado estos temas, las 

diferencias  son mínimas y como no son el mismo software, en el caso de hojas 

Excel se pierden decimales en operaciones, que al final terminan en estas 

diferencias mínimas, las cuales son aceptables. 

Finalmente también nos indica que el programa de Excel se pude mejorar, pero 

que también es una herramienta confiable para verificaciones, lo cual 

demuestra que siguiendo un proceso de cálculo adecuado y con criterio 

estructural se obtienen buenos resultados. 
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CAPÍTULO 6 

Traslado de datos a planos y detalles estructurales 

Del análisis y Diseño estructural final se van desarrollando los elementos 

estructurales tipo: 

Vigas: para este elemento se desarrolló un eje,  y así se deberá realizar para 

todos los demás niveles y ejes, con lo cual se obtiene una cantidad 

considerable  de ejes diseñados y estos a su vez se deberán plasmar en planos 

según muestra. 

Columnas: de este elemento se diseñó una columna, normalmente se terminan 

diseñando dos o tres tipos por nivel y que a su vez sirvan para   tres  o cuatro 

niveles. 

Cimentación: por ser un concepto más amplio y que está determinado por un 

estudio de suelos y geológico, conlleva más criterio y sería interesante un 

estudio más profundo sobre este tema. En un edificio como estos normalmente 

pueden ser zapatas concéntricas unidas con vigas de amarre, y a su vez sobre 

pilotes, esto como un criterio, pero puede cambiar a una placa de cimentación y 

pilotes, todo dependerá de los estudios correspondientes de suelos. 

El traslado de esta información a planos debe ser un proceso de constante 

supervisión durante su proceso (dibujo), ya que una mala interpretación va a 

dar como resultado otro proyecto que no corresponderá al calculado y 

diseñado, por lo tanto losas, vigas, columnas, cimentación y sus respectivos 

detalles serán el reflejo del ANÁLISIS Y DISEÑO ESTRUCTURAL, desarrollado 

con  criterio, además del uso adecuado del programa de análisis y diseño 

estructural como lo es Etabs.9.5 
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En esta fase debe regir la INGENIERÍA DE DETALLE, la cual nos indica de lo 

importante que es el detallado y sobre todo las indicaciones que deben 

prevalecer, por ejemplo que Eje se considera principal y cual principal 

secundario, de este concepto se refleja que el eje principal secundaria su 

peralte efectivo será más pequeño que el eje principal,  en consecuencia se 

deberá reflejar en los planos y tomar muy en cuenta en los diseños. 

Lógicamente si las vigas de eje Letras y Números son consideradas iguales, 

siempre la que se considere principal secundaria tendrá el menor peralte 

efectivo, considerando que ha menor peralte, menor capacidad en momentos, y 

aunque la diferencia sea de pulgadas, si puede repercutir en la capacidad. 

Por lo tanto es necesario dejar bien plasmado en planos lo anterior. Es 

necesario caracterizar en forma general una viga, una columna y los nudos que 

sean necesarios. 

Además de identificar cada eje, ya sea el principal y principal secundario. A 

continuación se presentan un eje de viga armado, la columna y el nudo 

respectivo, requiriendo que esto se debe hacer cuantas veces sea necesario en 

el juego de planos estructurales. 

También es necesario de tener un orden en la elaboración de planos 

estructurales, teniendo el siguiente orden en los planos: 

Cimentación + columnas de Sotano4 (Nivel de cimentación) 

Columnas de Sótano 3: (Nivel siguiente) el cual puede ser válido para dos o 

tres niveles superiores, y en consecuencia se deberá indicar  y quedaría así: 

Columnas de Sotano3 al 1 (por citar un ejemplo) 

Columnas Nivel 1 al 5: y así sucesivamente, además de ir numerando todos 

los planos para tener siempre referencia de la cimentación y columnas. 
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Detalles estructurales de cimentación: los cuales deberán contener tipos de 

zapatas, losa de cimentación, vigas de amarre, pilotes o lo que al final quede 

diseñado, aquí se deben indicar como se desarrollan los anclajes de las 

columnas y el desarrollo de traslapes verticales a lo alto del edificio. (Ver detalle 

final) 

Losas y vigas de Sótano 3, indicando si es aplicable a dos niveles, caso 

contrario se tendrán igual número de planos que niveles. 

Detalles estructurales de Losas y vigas: los cuales se  desarrollan como van 

quedando lo ejes totalmente armados y su continuidad en los refuerzos, aquí se 

verifican los peraltes cuando se cruzan dos vigas. 

Plano de especificaciones estructurales: este plano deberá contener la mayor 

información posible del proyecto, desde los códigos, cargas vivas, anclajes, 

traslapes, esfuerzos de los materiales (F`c, fy, valor soporte) con lo cual ayuda 

a desarrollar eficientemente el proyecto. 

Importante indicar en los planos las características del detalle de ingeniería, 

Para visualizar mejor lo referente a traslado de datos a planos y detalles 

estructurales se desarrollaron cuatro planos típicos, los cuales muestran todos 

los criterios antes mencionados y los cuales se adjuntan en apéndice A. 
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CONCLUSIONES 

 

1. El programa de Etabs es eficiente para análisis y diseño estructural, 

como se comprobó en el modelo realizado. 

2. Este programa es una herramienta de gran ayuda, pero se debe 

entender que cualquier error, se reflejará en los resultados, por lo tanto 

no se debe ver como  un programa de introducir datos. 

3. Es importante tomarse el tiempo necesario para plasmar en papel, la 

geometría (planta y elevaciones)  y distribución de cargas, con criterios 

propios, es decir introducir información en las dimensionales que siempre 

uno trabaja, (kg-m, lbs.-pie) esto evita muchos errores. 

4. El monitorear el proceso, es decir chequeos constantes en las diferentes 

fases del Análisis y diseño estructural. (geometría, cargas 

gravitacionales, estáticas y dinámicas.) nos genera confianza y certeza 

en el programa. 

5. Tomar en cuenta que NO se llegará a dominar el programa al 100%, por 

lo que se puede usar solo para Análisis o  Análisis y Diseño  según el 

conocimiento y confianza que se tenga. 

6.  Este programa,  Etabs, están bien idealizados, que muchas veces se 

cree que realizan los cálculos y diseños con solo pulsar un botón, siendo 

esto un concepto erróneo. 

7. Por ningún motivo se elimina el criterio del ingeniero estructural, como 

quedó demostró en el análisis y diseños estructural, simplemente estos 

programas facilitan los procesos de análisis y diseños. 
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8. Las diferencias de datos finales están dentro del rango del 1% al 5% 

máximo, y se consideran bien, considerando que al final la cantidad de 

refuerzo siempre es mayor a la requerida, esto debido a que siempre se 

colocan varillas completas. 
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RECOMENDACIONES 

 

1. Se recomienda antes de usar estos programas de Etabs u otro programa, 

realizar un curso básico-intermedio, para entender el uso, y como aplica 

los diferentes parámetros de códigos estructurales que se usan en estos 

análisis y diseños. 

2. Que el usuario posea una base suficiente sobre estructuras, es decir que 

le guste la rama estructural, para entender cuándo se pueden cambiar 

parámetros aplicados a determinada estructura. 

3. Iniciar con modelos típicos, (tipo-Mesa) y un solo nivel, para ir 

entendiendo de una mejor forma cómo trabajan los programas, y cómo 

todo proceso de ingeniería, siguiendo con modelos más complejos, esto 

va generando confianza y habilidad para su uso. 

4. A los profesionales que se inician en estos programas, usarlos solo para 

análisis estructural, esto va proporcionando confiabilidad en el uso, 

además los análisis son relativamente más fáciles y lógicos de 

determinar si están bien. 

5. Cuando ya se tenga la suficiente confiabilidad y sobre todo, en tener un 

mejor dominio de los programas, proceder con la fase de Diseño 

estructural, previsto en los programas. 

6. Siempre realizar los diseños paralelos en programas desarrollados en 

hojas Excel, esto dará la satisfacción  y confiabilidad de haber realizado 

un buen cálculo y diseño  estructural. 



 

 

136 
 

7. Finalmente se dará cuenta uno de lo complejo que es este proceso, pero  

además de lo adecuado que realmente es el programa, cuando se hace 

buen uso del mismo. 

8. Siempre esquematizar el proyecto, con  características propias, es decir 

realizarlo como uno lo haría manualmente, esto aclara bastante el 

proceso de introducción de datos y evita errores. 
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Fuente: AGIES 2010 
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Nivel Mínimo de protección sísmica y probabilidad del sismo de diseño 

 

Fuente: AGIES NSE 2-10. 

 

Coeficiente de sitio Fa 

 

 

Fuente: AGIES NSE 2-10. 

Coeficiente de sitio Fv 

 

 

 

 

 

 

Fuente: AGIES NSE 2-10. 
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Factor Na para períodos cortos de vibración 

 

 

 

 

 

 

 

 

 

 

Fuente: AGIES NSE 2-10. 

 

Factor Nv para períodos largos de vibración 

 

 

 

 

 

 

 

Fuente: AGIES NSE 2-10. 
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Coeficientes y factores de diseño de sistemas sismo resistentes 

 

 

 

Fuente: AGIES NSE 3-10. 
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Coeficientes y factores de diseño de sistemas sismo resistentes 

(continuación) 

 

 

 

Fuente: AGIES NSE 3-10.  

 

 

 


